Chapter 1
What is FactoryTalk Historian Classic? .................................................. 9
Features and Benefits .............................................................................. 9
Intended Audience ........................................................................................ 9
Where Can I Go for Help? ....................................................................... 11

Chapter 2
The RSBizWare Architecture .................................................................. 13
Connecting to the Information Services Manager ..................................... 14
Using the Information Services Manager in Internet Explorer .......... 14
Using the Configuration Console ..................................................... 15
Exploring the User Interface ..................................................................... 16
The Report Explorer ............................................................................. 16
The Report Design and Display Work Area ................................... 16
Shortcut Menus ...................................................................................... 17

Chapter 3
The Plant Model.......................................................................................... 19
Configuring the Plant Model .............................................................. 20
Configure Time-Series Data Collection ................................................ 22
Types of control connectors for the data collection ...................... 23
Enterprise Connectors .......................................................................... 24
Tutorial .................................................................................................... 25
Step 1: Start the Time-Series Data Collection Wizard ........... 25
Step 2: Select the Source and Destination of the Time-Series
Data 25
Step 3: Create or Select Data Points ............................................ 27
Step 4: Configure Collection Parameters ................................... 31
Step 5: Configure Transaction Settings ...................................... 34
Step 6: Create Transactions ........................................................... 36
Organize FactoryTalk Historian Classic Reporting Tags ................. 36
Start Data Collection ................................................................................. 39

Chapter 4
Create a New RSBizWare Report ........................................................... 41
Insert Text, Pictures, and Hyperlinks................................................. 42
# Table of Contents

Save the Report .................................................................................................................. 44
Add a Saved Report Object to Your Report ................................................................. 45
Configure the Report Object To Use Global Credentials ........................................... 48
Create a New Chart ............................................................................................................. 51
  Step 1: Plan the Chart ...................................................................................................... 52
  Step 2: Select the Data On Which To Report ............................................................... 53
  Step 3: Choose a Chart Type ........................................................................................... 53
  Step 4: Describe the Data ............................................................................................... 53
  Step 5: Select Summary or Detail ..................................................................................... 54
  Step 6: Select the Fields To Be Charted ........................................................................... 55
  Step 7: Enter the Chart Title ............................................................................................ 56
  Step 8: Filter the Data ....................................................................................................... 56
  Step 9: Insert Your New Chart Into the Report ............................................................. 59
Create a New Text Report Object ..................................................................................... 60
  Step 1: Start the Text Report Object Wizard ................................................................. 61
  Step 2: Select the Data On Which To Report ............................................................... 61
  Step 3: Group the Records ............................................................................................... 62
  Step 4: Sort the Records .................................................................................................. 63
  Step 5: Format the Table .................................................................................................. 64
  Step 6: Name the Report Object ...................................................................................... 66
  Step 7: Filter the Data ....................................................................................................... 66
  Step 8: Insert Your New Table Into the Report .............................................................. 66
Create a Time-series Chart ............................................................................................... 67
  Step 1: Create the Report Object ..................................................................................... 67
  Step 2: Name the Report Object ..................................................................................... 68
  Step 3: Add Reporting Tags ............................................................................................. 68
  Step 4: Apply an Analysis Tool .......................................................................................... 69
  Step 5: Customize the Chart Legend ............................................................................... 70
  Step 6: Insert Your New Chart Into the Report ............................................................. 71
  Step 7: Adjust the Time Range .......................................................................................... 71
  Step 3: Add Reporting Tags ............................................................................................. 73
  Step 9: Remove a Reporting Tag or an Analysis Tool ..................................................... 76
Create a Simple Batch/Event Chart .................................................................................. 76
Add a Comment to a Value, X-axis, or Y-axis on a Time-series Chart ............................. 79
  Value Comments .............................................................................................................. 80
# Table of Contents

**Customizing RSBizWare Charts and Tables**

- X-axis Comments ................................................................. 81
- Y-axis Comments ...................................................................... 82
- Ad Comment As ....................................................................... 84
- Export the Report to HTML ..................................................... 84
- Load the Report From File ....................................................... 85

**Chapter 5**

- Customizing Charts ................................................................ 87
  - Working With the Component Parts of a Chart ..................... 88
  - Resizing a Component .......................................................... 89
  - Moving a Component ........................................................... 89
  - Deleting a Component ........................................................... 89
  - Editing the Chart Title or Text Field .................................... 89
  - Changing Chart Component Properties ............................... 90
  - Working With Chart “Pens” ................................................. 90
  - Customizing Text Report Objects ........................................... 90
  - Show and Hide Columns.......................................................... 91
  - Resize Table Columns ............................................................ 92
  - Aggregate, Group, Format, Sort, Chart, and Rename Columns 92
    - Aggregate ........................................................................... 93
    - Group .................................................................................. 94
    - Format .................................................................................. 94
    - Sort ..................................................................................... 94
    - Chart ..................................................................................... 95
    - Rename ................................................................................ 95
  - Quick Filter ............................................................................. 95

**Chapter 6**

- The Excel Add-in ................................................................. 97
- Scheduling Report Objects and Reports .................................... 101
  - Schedule a Report Object ....................................................... 102
  - Schedule a Report .................................................................. 105
  - View the History of the Scheduled Task ................................. 109
- Analyzing Non-RSBizWare Data .............................................. 110
  - Create an External Data Source ........................................... 110
  - Create a Report Data Source ............................................... 111
  - Step 1: Start the Report Data Source Wizard ......................... 111
Creating RSBizWare Custom Analysis Tools

Chapter 7
Why Use Custom Analysis Tools?....................................................... 125
Intended Audience................................................................................... 125
A Quick Tour of a Sample Custom Analysis Tool .......................... 126
Registering a Sample Analysis Tool................................................ 127
Using the Sample Analysis Tool for Time-series Analysis ...... 129
What You Need to Know Before You Start ................................. 129
Analysis Tool Architecture................................................................. 130
What a Time-series Data Set Looks Like ........................................... 132
Interpreting the Parameters Passed into the Calculate() Function
133
Limitations ........................................................................................... 134
The RSBizWare Calculator COM Interface..................................... 134
Looking at the Type Library............................................................... 135
Developing Analysis Tools with Visual Basic.............................. 136
Creating a New Project...................................................................... 137
Configuring Important Project Settings ....................................... 137
Referencing the RSBizWare Calculator Component ................ 138
Writing the Calculate() Function.................................................. 138
Saving and Compiling the Project ................................................. 140
Trying Out the New Custom Analysis Tool ................................. 141
Debugging Custom Analysis Tools in Visual Basic ................. 142
Developing Analysis Tools with Visual C++............................. 143
Creating a New Project.................................................................. 144
Referencing the RSBizWare Calculator Component ............... 145
Working with VARIANTs in Visual C++ ................................. 147
Writing the Calculate() Function............................................... 148
Object Permissions

Chapter 8

Object Permissions

Filter permissions ................................................................. 158
Report permissions .............................................................. 158
Report data source permissions ........................................... 159
Report object permissions .................................................. 159

Chapter 8

Filter permissions ..................................................................................... 158
Report permissions ................................................................................... 158
Report data source permissions ............................................................. 159
Report object permissions ...................................................................... 159
Chapter 1

Welcome to FactoryTalk Historian Classic

What is FactoryTalk Historian Classic?

The RSBizWare software is a suite of tools and services aimed at increasing your manufacturing floor effectiveness and profitability with solutions that target performance analysis and improvement and with data acquisition and integration. FactoryTalk Historian Classic is just one of the applications that is available within the RSBizWare software. FactoryTalk Historian Classic is a repository for historical data, built for today’s networked and distributed enterprise. Tightly coupled to FactoryTalk Transaction Manager for data collection, FactoryTalk Historian Classic ships with a complete, predesigned data model for time-series data logging, and offers the ability to analyze data from external database tables.

Features and Benefits

FactoryTalk Historian Classic offers the following features and benefits:

- Rich reporting, graphing, time-series analysis, and querying functionality provide a complete and easy-to-use solution for performance analysis.
- A direct link between the shop floor, where data is collected, and the enterprise, where data can be analyzed and reported on.
- The ability to embed a report object in any Microsoft ActiveX container, such as Visual Basic or Internet Explorer.
- The ability to analyze data contained in non-RSBizWare databases.

Intended Audience

The FactoryTalk Historian Classic User Guide is designed to help you understand how to access and use the FactoryTalk Historian Classic product. This document focuses on the end-user functions of
FactoryTalk Historian Classic and does not cover installation and operation of underlying system services.

This document is intended for the following types of users of the RSBizWare software:

- **RSBizWare administrators**
  RSBizWare administrators configure the RSBizWare system so that it can capture performance data for use by report designers and report users.
  They should be familiar with:
  - Control systems, process information (line and plant), and databases.
  - Microsoft Windows operating system.
  - The location and structure of databases.

- **Report designers**
  Report designers create the reports that will be used by report users.
  They should be familiar with:
  - Process information (the physical representation of the production line and plant).
  - Microsoft Windows operating systems.
  - Query logic (how to write a database query).
  - Web publishing tools.
  - The location and structure of databases.

- **Report users**
  Report users make use of the reports created by the report designer to perform their jobs.
  They should be familiar with:
• Microsoft Windows operating systems.

Where Can I Go for Help?

Consult the following resources for additional information about the product:

• Release Notes
  The release notes contain current information about the product, including hardware and software requirements, new features, known and fixed anomalies.

• RSBizWare Administration Guide
  The administration guide helps the RSBizWare administrator install and configure the software as well as understand the architecture of the RSBizWare suite and its components.

• Online help
  The online help provides general information and step-by-step procedures for working with the product.

• Rockwell Automation Support Center
  The support center provides a variety of services, such as trainings, webinars, and online support that will improve your experience using the RSBizWare suite.
Getting Started

Before you walk through the examples and tutorials that are discussed in this book, it is assumed that the RSBizWare administrator has installed, configured, and started the Information Services Manager on the server computer.

The RSBizWare Architecture

The RSBizWare architecture is a scalable, multi-tiered, distributed architecture consisting of a data collection subsystem, an Oracle or SQL Server database repository, the Information Services Manager, and clients. Rockwell Automation’s FactoryTalk Transaction Manager is the embedded engine that collects data from the control system(s), and the Metrics Server Manager logs it to the predefined RSBizWare database repository. There are several types of clients, including the Configuration Console and the Internet Explorer Web client.
The RSBizWare architecture can be configured to run on a single computer, or it can be distributed across multiple computers. In the simplest case, the Configuration Console, the Information Services Manager, the RSBizWare administrative tools used by the RSBizWare administrator, the database, the Metrics Server Manager, and the FactoryTalk Transaction Manager data collection engine run on a single computer. In a distributed setting, these components may reside on separate computers. Clients connect to the Information Services Manager using TCP/IP, so they can be deployed over a LAN, WAN, intranet, or the Internet. The scalability of the RSBizWare architecture allows many clients to connect to a single server.

**Connecting to the Information Services Manager**

RSBizWare reports created by the report designer are saved to the Information Services Manager, and are available online over a TCP/IP network. If you wish to create and edit RSBizWare reports using Microsoft Internet Explorer, you need to run the Configuration Console.

**Using the Information Services Manager in Internet Explorer**

Using Microsoft Internet Explorer to view RSBizWare reports, you can connect to the Information Services Manager without having the RSBizWare software installed on your computer. Instead, the server hosts a special Web page, the Quick Web, to give you access to the RSBizWare reports stored on the server. This option only allows you to view RSBizWare reports.

To access the Quick Web, open Internet Explorer, type the Web address for the Information Services Manager computer, and press Enter on your keyboard.

The Web address is made up of the name of the server computer and the HTTP port number used by the server computer, separated by a colon.

For example, if you were attempting to connect to a server computer named `rsi-rockwell` that uses the default HTTP port `8080`, you...
would use the following address: http://rsi-rockwell:8080. Please contact your RSBizWare administrator for the specific Information Services Manager Web address to which you should connect.

The first time you try to use the Quick Web, you need to download several ActiveX controls from the server computer. The download will begin automatically.

After you have downloaded the ActiveX controls from the Information Services Manager, you may be prompted to log on. If prompted, type the user name and password for the account that your RSBizWare administrator has authorized for you, and then click OK. A connection to the RSBizWare server is established.

If you wish to configure your plant model, manage the collection of control system data, and/or edit RSBizWare reports, you should connect to the Information Services Manager via the Configuration Console. Your RSBizWare administrator must assign a FactoryTalk Metrics Author license and the appropriate privileges to you before you will be able to perform these functions.

You must have the Client software installed on your computer before you can run the Configuration Console. To install the Configuration Console from the RSBizWare CD, select the “Minimal” install option.

1. To start the Configuration Console, select Programs > Rockwell Software > RSBizWare > Configuration Console.

2. If you have not already logged into RSBizWare, the Login dialog will display. Enter the user name and password for the account your RSBizWare administrator has authorized for you. Enter the name of the server computer where the Information Services Manager is running in the Server box. Click Login.
The status bar at the bottom of the client application shows your user name, the activations that have been assigned to you, and the Information Services Manager to which you are connected.

### Exploring the User Interface

When you start the Configuration Console, you will notice that the user interface is made up of two main components: the Report Explorer and the report design and display work area.

#### The Report Explorer

The Report Explorer is a hierarchical navigation tool used for organizing RSBizWare reports that have been saved for future use. The Report Explorer contains the reports that have been saved on the Information Services Manager to which you are connected and for which you have been granted view permissions. Your ability to modify and delete the reports listed on the Report Explorer is dependent on the licenses and features that have been assigned to you by your RSBizWare administrator and the permissions that have been granted to you by the creator of each individual report.

#### The Report Design and Display Work Area

When you click an item in the Report Explorer, the specified RSBizWare report will display in the work area to the right of the...
Report Explorer. The work area is the region where report designers can create and modify reports.

**Shortcut Menus**

Many areas of the application give you access to shortcut menus. The shortcut menu allows you to perform frequently used commands without using the main application menu or toolbar buttons. To view the shortcut menu, you need to right-click in the area of the desired application. The shortcut menu contains commands that are appropriate for the selected area. For example, if you right-click the Report Explorer, the shortcut menu will contain commands that apply to the Report Explorer.
Collecting FactoryTalk Historian Classic Data

The primary functions of FactoryTalk Historian Classic are to collect and analyze time-series data. Before the report designer can create time-series analysis reports for the report user, the RSBizWare administrator must set up the application to collect data from the control system. The tutorials in this chapter will help you understand how to use FactoryTalk Historian Classic to collect time-series data. We will:

- Configure the plant model for your FactoryTalk Historian Classic installation
- Configure time-series data collection
- Organize FactoryTalk Historian Classic reporting tags
- Start and stop data collection

The tutorial in "Analyzing FactoryTalk Historian Classic Data (page 41)" will help you understand how to analyze the data that is collected in FactoryTalk Historian Classic.

The Plant Model

The plant model is made up of activity areas - enterprises, sites, areas, lines, and workcells - as well as of equipment and labor resources. The activity areas are based on the terms defined by the Instrument Society of America (ISA) S95 standard in order to provide common terminology for improved communication and integration between control systems and enterprise systems.
Chapter 3  Collecting FactoryTalk Historian Classic Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workcell</td>
<td>A location and/or group of equipment used to perform work in a manufacturing process. The operations in a manufacturing process are performed at workcells. A workcell is typically a physical location and a primary resource (e.g., a machine); however, it may also represent a logical grouping of primary resources from which a selection is made.</td>
</tr>
<tr>
<td>Line</td>
<td>A collection of one or more workcells that are combined to perform work. The workcells in a line are either physically located close to one another, or are related to one another in the production process (the production result of the first workcell in a line feeds the second workcell in the line).</td>
</tr>
<tr>
<td>Area</td>
<td>A physical, geographical, or logical grouping of lines and/or workcells within a site, typically representing a main production capability (e.g., electronic assembly) within a manufacturing location.</td>
</tr>
<tr>
<td>Site</td>
<td>A group of areas, lines, and workcells representing a geographical location at which products are manufactured.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>The highest-level activity area, typically representing the business.</td>
</tr>
</tbody>
</table>

The plant model may be used by all RSBizWare applications in your organization (FactoryTalk Metrics, FactoryTalk Historian Classic, and FactoryTalk Scheduler). The enterprises, sites, areas, lines, and workcells in your plant model are the subjects of your performance parameter evaluation. For implementations of RSBizWare that incorporate the FactoryTalk Scheduler application, the plant model also includes capacity, which is the property of an activity area describing its availability over time. The performance parameters can also be configured for resources.

**Configuring the Plant Model**

To create and edit the plant model, you must be granted the Organize Plant Model privilege by your RSBizWare administrator. If you want to have access to sample data, see "Loading Sample Activity Areas".

To configure the plant model in the Configuration Console:

1. On the Configure menu, click Plant Model.
The **Plant Model** dialog box appears.

2. Right-click in the area under the plant model tree, and then click **New Root Enterprise**.

A new enterprise is added to the tree.

![Plant Model dialog box](image)

3. Change the default name to **Sample Enterprise**, and then press Enter.

4. Right-click **Sample Enterprise**, and then click **New Activity Area > Site**.

A new site is added to the tree.

5. Change the default name to **Sample Site**.

6. Right-click **Sample Site**, and then click **New Activity Area > Area**.

A new area is added to the tree.

7. Change the default name to **Sample Area**.

8. Right-click **Sample Area**, and then click **New Activity Area > Line**.

A new line is added to the tree.

9. Change the default name to **Sample Line**.

10. Right-click **Sample Line**, and then click **New Activity Area > Work Cell**.

A new workcell is added to the tree.

11. Change the default name to **Sample Work Cell 1**.
12. Right-click each activity area that you have created, and then click Add Capacity.

**TIP**
The capacity of an activity area describes its availability over time. Add capacity for your activity areas so that you can associate them with time patterns.

13. Click OK.

**Configure Time-Series Data Collection**

FactoryTalk Historian Classic uses FactoryTalk Transaction Manager to collect data from the control system and log it into the RSBizWare database. A FactoryTalk Transaction Manager configuration connects any control system from which data will be collected to the predefined data model used by the RSBizWare database to store time-series data. The configuration consists of transactions and the connectors, data points, and data objects required to implement the transactions.

A transaction is a single exchange of data between the industrial control system - typically a network of programmable logic controllers (PLCs) - and a database. An example of a transaction is a temperature value that is collected from a data point on a programmable logic controller and logged to a database table.
A data point is a specific data location or register in the control system that is made available to FactoryTalk Transaction Manager transactions. After it is defined, a data point can be used by any FactoryTalk Transaction Manager transaction.

The FactoryTalk Transaction Manager interfaces with the industrial control system device via a control connector. A control connector is a Windows service that collects data from a data server, such as a PLC and sends it to the FactoryTalk Transaction Manager.

You can use the following types of control connectors:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Data Exchange (DDE)</td>
<td>The DDE control connector service is provided for legacy connections to DDE servers or to provide functionality that is not supported by the OPC specification.</td>
</tr>
<tr>
<td>RSLinx Classic OPC</td>
<td>The RSLinx Classic control connector service is the preferred method to use when browsing for data tags that reside in Allen-Bradley Programmable Logic Controllers, except for ControlLogix 555x processor items. You should use Generic OPC control connectors with ControlLogix 555x processors.</td>
</tr>
<tr>
<td>Generic OPC</td>
<td>The Generic OPC control connector service is used to interface with items provided by any OPC server that conforms to OPC interface specifications.</td>
</tr>
<tr>
<td>FactoryTalk LiveData Connector</td>
<td>FactoryTalk Transaction Manager uses FactoryTalk Live Data to communicate with FactoryTalk Live Data servers, such as RSLinx Classic and RSView Supervisory Edition. FactoryTalk Transaction Manager connects to the FactoryTalk Directory, which allows FactoryTalk Transaction Manager to browse the available data items. This control connector is required if you plan to perform online edits with your configuration.</td>
</tr>
</tbody>
</table>
Enterprise Connectors

The FactoryTalk Transaction Manager interfaces with the database via an enterprise connector. An enterprise connector is a Windows service that receives data from the FactoryTalk Transaction Manager and logs it to a database.

The following are the types of enterprise connectors that you can use:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODBC</td>
<td>The ODBC enterprise database connector allows you to interface with virtually any ODBC-compliant database including Microsoft Access, Microsoft SQL Server 6.5 or later, IBM DB2 or Sybase.</td>
</tr>
<tr>
<td>Oracle OCI</td>
<td>The Oracle Call Interface (OCI) enterprise database connector allows you to connect to database objects from an Oracle server. If you are using Oracle OCI, you need to install locally SQL*NET 2.3x or later, Net8, or Oracle Net services (all from Oracle). You can then connect to an Oracle database versions 9i through 11g.</td>
</tr>
<tr>
<td>Microsoft OLE DB</td>
<td>The Microsoft OLE DB enterprise database connector should only be used for interfacing with Microsoft SQL Server. Microsoft OLE DB allows you to browse an SQL Server database without a data source name (DSN) and is the preferred method of connection.</td>
</tr>
<tr>
<td>Microsoft COM+</td>
<td>The Microsoft COM+ enterprise application connector allows you to interface with Microsoft COM+ application components. These components must be integrated into a Windows 2000 COM+ environment. RSBizWare-only applications do not support this connector. It is for use only with FactoryTalk Transaction Manager Professional installations.</td>
</tr>
<tr>
<td>FactoryTalk Metrics</td>
<td>The FactoryTalk Metrics enterprise application connector is used only with FactoryTalk Metrics. The connector stores data in the RSBizWare database.</td>
</tr>
<tr>
<td>SAP</td>
<td>The SAP enterprise application connector allows you to interface with SAP R/3 systems modules. RSBizWare-only applications do not support this connector. It is for use only with FactoryTalk Transaction Manager Professional installations.</td>
</tr>
</tbody>
</table>
This connector stores time-series data in a pre-defined compressed format in either an Oracle database or a Microsoft SQL Server database. The compressed data point records contain binary data that can only be viewed through FactoryTalk Historian Classic. For a detailed description of data compression and the Compression connector, see the Administration Guide, section "Data Compression".

**Tutorial**

This tutorial will help you understand how to use the Time-Series Data Collection Wizard to collect reporting tag data. A reporting tag is a particular item of collected time-series data—independent of the method or source of collection—that can be charted in RSBizWare reports.

For this tutorial, we will be using the Time-Series Data Collection Wizard to configure FactoryTalk Transaction Manager transactions that will collect values from the control system and log the values to a reporting tag in the RSBizWare database.

**NOTE**

To configure time-series data collection, you must be granted a FactoryTalk Historian Classic Author license by your RSBizWare administrator.

**Step 1: Start the Time-Series Data Collection Wizard**

From the Configuration Console menu, select **Configure > FactoryTalk Historian Classic > Time-Series Data Collection** to display the Time-Series Data Collection Wizard welcome screen. Click **Next** on the Welcome dialog box.

**Step 2: Select the Source and Destination of the Time-Series Data**

The Collection Source and Destination dialog box, which allows you to specify where the time-series data will be collected from and where it will be stored in the RSBizWare database, will display.
Chapter 3  Collecting FactoryTalk Historian Classic Data

1. The report data source is the database table or view where the data will be stored. FactoryTalk Historian Classic is capable of logging data to the FactoryTalk Historian Classic Data Point Default report data source (the RSDataPointSample table in the RSBizWare database), the FactoryTalk Historian Classic Data Point Compressed report data source (the RSSQL_CMPCOMPRESS table in the RSBizWare database), or to any other database table or view that your organization identifies as supporting the required time-series data model (Advanced option). For this tutorial, accept the default Historian Data Point Default option.

   **TIP**  For more information about creating additional report data sources, refer to "Analyzing Non-RSBizWare Data (page 110)."

2. Now you must specify the FactoryTalk Transaction Manager configuration that will be used to support data collection. The FactoryTalk Transaction Manager Configuration list contains the configurations that have been associated with FactoryTalk Historian Classic for the server to which you are connected. If we had selected a compression report data source in the previous step, only FactoryTalk Transaction Manager
configurations that had Compression Enterprise Connections would be available here. Since we selected a non-compression report data source, any FactoryTalk Transaction Manager configurations that have non-compression (OLE DB, OCI, or ODBC) enterprise connectors will be available.

3. The Enterprise Connector is the service that will manage the connection between the FactoryTalk Transaction Manager configuration and the database. The FactoryTalk Transaction Manager Enterprise Connection list contains the enterprise connectors that are available from the configuration that you selected. From the Enterprise Connection list, select the **OLE-DB_Connector**.

4. Click **Next** to continue.

If the FactoryTalk Transaction Manager configuration is already running and is enabled for online edits, you can edit the configuration without stopping it. However, if the configuration is running and is not enabled for online edits, the wizard will prompt you to stop the configuration. If you do not stop the configuration, the Time- Series Data Collection Wizard cannot make changes to the configuration, and the wizard will close automatically.

**NOTE**
The FactoryTalk Transaction Manager Live Data Migration Tool allows you to convert configurations with non-FactoryTalk data points into FactoryTalk data points. For additional information about editing a running configuration and using the FactoryTalk Transaction Manager Live Data Migration Tool, see the “Online Edits” topic in the online help.

---

**Step 3: Create or Select Data Points**

Next you’ll see the FactoryTalk Transaction Manager to FactoryTalk Historian Classic Reporting dialog. This dialog enables you to select the FactoryTalk Transaction Manager data points from which FactoryTalk Historian Classic will be collecting data and enables you to specify the FactoryTalk Historian Classic reporting tags to which the data will be logged.
1. To select the data points from which data will be collected, click the **Add** button. The Select FactoryTalk Transaction Manager Data Points dialog that is displayed lists the data points that exist in the FactoryTalk Transaction Manager configuration. The top of the dialog is simply a set of tools that you can use to filter the data point list.
2. To add new data points to the FactoryTalk Transaction Manager configuration, click the **Add/Edit Points** button to display the (FactoryTalk Transaction Manager) FactoryTalk Data Point dialog box.
This dialog may look different depending on the type of control connector that you selected. This dialog allows you to add data points to the Control Connector and set their properties.

3. If you were creating new tags from a running FactoryTalk Transaction Manager configuration, you would select them by selecting a category of tags from the Folders tree, selecting the actual tags from the Contents of “/” list, clicking the Add Selected Tag(s) button, and clicking the Apply button. For now, click Close to exit the dialog and return to the Select FactoryTalk Transaction Manager Data Points step of the Time-Series Data Collection Wizard.

4. Highlight the data points for which you want to collect data. For this tutorial, select the BEND_Breakdown data point (unscheduled) and the BEND_BreakdownCode data point (scheduled). Click Select to return to the From FactoryTalk Transaction Manager to FactoryTalk Historian Classic Reporting Tags step of the Time-Series Data Collection Wizard.
The selected data points have been added to the list of data points for which you will be creating transactions. Since we are collecting data from newly selected data points, the FactoryTalk Historian Classic Reporting Tag column does not yet contain reporting tag names that will be associated with the values when they are stored in the database.

5. You can associate each data point with an existing reporting tag or you can have the application create a new reporting tag for you. To associate an existing reporting tag with a data point, you would select the data point from the list and click the Change button to display the Select FactoryTalk Historian Classic Reporting Tag dialog. You would then select the reporting tag with which you want to associate the selected data point and click OK to close the dialog. This approach is useful if you have a data point/reporting tag association that you want to change. For this tutorial, accept the reporting tag names that the application generates by clicking Next.

Step 4: Configure Collection Parameters

The next step in the process is to assign collection parameters to the selected data points. If you have selected data points that are configured as scheduled, the FactoryTalk Transaction Manager Scheduled Transaction dialog box will display. If you have selected data points that are configured as unscheduled, the FactoryTalk
Transaction Manager Unscheduled Transaction dialog box will display. If you have selected both scheduled and unscheduled data points, the FactoryTalk Transaction Manager Scheduled Transaction dialog box and the FactoryTalk Transaction Manager Unscheduled Transaction dialog boxes will both be displayed.

**Scheduled transactions.** Use the FactoryTalk Transaction Manager Scheduled Transaction dialog box to indicate how often to poll the control system and log the data to the RSBizWare database (e.g., once every 15 seconds).

1. The Simple Scheduled FactoryTalk Transaction Manager Transaction option is useful if you want to trigger the transaction on simple scheduled events such as system start up or system shut down. If you want to set more sophisticated triggers for the transaction, select the Advanced FactoryTalk Transaction Manager Transaction option. For this tutorial, accept the default Simple Scheduled FactoryTalk Transaction Manager Transaction option and the default Starting Event (SYS_STARTUP) and Stopping Event (SYS_SHUTDOWN).
2. Set the scan rate to 15 seconds. This means we will be collecting data every 15 seconds between the time the configuration is started and the time the configuration is stopped.

3. Click Next to continue.

**Unscheduled transactions.** Unscheduled transactions are triggered by a change in the value of the data point that is being logged. The FactoryTalk Transaction Manager Unscheduled Transaction dialog box allows you to trigger the transaction when the data point value goes high, low, or on any change in the data point value.

1. For our example, accept the default On Change option. This option means that any time our data point value changes, a value will be logged to the database.

2. Select the Specify Minimum Collection Frequency (MCF) check box to create a scheduled transaction that will be paired with your unscheduled transaction. The values from both transactions will be logged to the same field in the database. The data from the scheduled transaction will create a “heartbeat” that will allow us to determine that the
configuration is still running even if our unscheduled transaction has not been logged for a while. If you do not use a minimum collection frequency and your unscheduled transaction has not been logged for a while (this is called a deadband), it may be difficult to determine if the FactoryTalk Transaction Manager configuration is still running.

For additional information on setting a minimum collection frequency, see the “Deadbanding” topic in the online help.

3. Enter 15 in the Collect Value Every box and accept the default Seconds option. This will cause the application to collect a “heartbeat” value every 15 seconds.

4. Click Next to continue.

Step 5: Configure Transaction Settings

The FactoryTalk Transaction Manager Transaction Settings dialog box enables you to specify how the transaction data will be stored in the database and to specify how long FactoryTalk Transaction Manager will wait for the transaction to complete before logging an error.
1. The Transaction Storage options allow you to specify how the data will be stored to the database.

   • Cache Transaction File—The FactoryTalk Transaction Manager will write data values to a file for a specified period of time or a specified number of transactions. When the file reaches the specified limit, the Enterprise Connector reads and processes the records in the file. The Cache Transaction File option is most appropriate for transactions that will be logged very often, such as a Scheduled data point that will be collected every 10 seconds or less.

   • Real Time Thread—The FactoryTalk Transaction Manager will send a message to the Enterprise Connector for each transaction as it is processed. The Real Time Thread option is most appropriate for transactions that will not be logged very often; for example, an unscheduled data point that triggers a transaction when its value changes and where the value of that data point changes infrequently.

Accept the default Cache Transaction File option.

2. The Transaction Timeout fields allow you to control how long FactoryTalk Transaction Manager will wait for the transaction to complete before logging an error. The transaction timeout should be set slightly higher than the length of time it will take for the data points to be collected, or be set to the length of time after which the transaction is no longer valid. For example, if a transaction should complete in 5 seconds but might take as long as 7 seconds and still be acceptable, you should set the transaction timeout to 8 seconds. If the transaction goes past 8 seconds, the transaction will fail, and an error will be logged.

Accept the default value of 60 seconds.

   • Click Next to continue.
Step 6: Create Transactions

The Summary dialog box gives you a chance to review the transactions that will be created.

1. If the transactions are correct, click **Create**.

2. The Results panel displays errors and warnings that occurred during the generation of FactoryTalk Transaction Manager transactions, if any. If the creation of transactions results in errors or warnings, double-click the entries in the summary list for more information about what went wrong, where the fault occurred, and the severity of the error.

   **NOTE**

   If the configuration that you are working with was a running configuration that you stopped in the first step of the wizard, the wizard will prompt you to restart the configuration. After the configuration is started, FactoryTalk Transaction Manager will begin to collect data and log it to the RSBizWare database.

3. Click **Finish** to close the wizard.

Organize FactoryTalk Historian Classic Reporting Tags

As you configure FactoryTalk Historian Classic data collection for your organization, you most likely will have a large number of reporting tags to which you are collecting data and from which you
will be creating reports; therefore, it is a good idea to organize your reporting tags.

**NOTE** To manage time-series reporting tags, you must be granted the Manage Reporting Tags privilege by your RSBizWare administrator.

1. From the main menu, select **Tools > FactoryTalk Historian Classic > Manage Time-Series Reporting Tags** to display the Time-Series Reporting Tags dialog. This dialog is the starting point for administering and managing reporting tags.

2. Select the time-series report data source that contains the reporting tags that you want to modify or organize. To view the reporting tags that we just created, select the **Historian Data Point Default** report data source. The Search Results list at the bottom of the dialog is refreshed to show the reporting tags in the selected report data source.

3. When the Search Results list contains too many entries for you to easily locate the reporting tags that you want to manage, use the Plant Model Activity Area control, the Reporting Tag Text Filtering control, or both to narrow the search results.
To perform an activity area search, click to the right of the Plant Model Activity Area box. Use the Plant Model Browser dialog that is displayed to select the activity area that you want to search. Click OK to return to the Time-Series Reporting Tags dialog. The Search Results list is refreshed to show the reporting tags in the report data source that are associated with the selected activity area. Our reporting tags have not yet been associated with an activity area, so a search by activity area would not return the reporting tags that we created in the previous tutorial. So click the Clear button if you selected an area in the Plant Model Browser dialog.

To perform a string search on the names of the reporting tags in the selected report data source, enter the text that you want to search for (using an “*” to represent a wild card character) and click Search Now. Reporting tags that match the search string are displayed in the list at the bottom of the dialog. For example, a string search for *BEND* would return the reporting tags that we created in the previous tutorial.

4. Select the BEND_Breakdown reporting tag from the list and click Edit to display the Reporting Tag dialog box. Use it to edit the name of the reporting tag, provide the engineering units, and associate the reporting tag with an activity area in the plant model.
5. Click OK to save your changes and return to the Time-Series Reporting Tags dialog.

6. Click OK to close the Time-Series Reporting Tags dialog.

**Start Data Collection**

After you have finished configuring the performance parameters, and enabled data collection for the activity areas that use a particular FactoryTalk Transaction Manager configuration, you need to start the FactoryTalk Transaction Manager configuration to begin the data collection.

**To start the data collection:**

1. On the Tools menu, click **FactoryTalk Transaction Manager > Manage FactoryTalk Transaction Manager Configurations.**

   The **FactoryTalk Transaction Manager Configurations** dialog box appears.

   It lists the FactoryTalk Transaction Manager configurations that have been imported, and the applications to which they apply. In the dialog box, you can evaluate the running status of FactoryTalk Transaction Manager configurations that are
collecting data from the control system, as well as start, stop, or restart the configurations.

2. Select a FactoryTalk Transaction Manager configuration, and then click **Start**.

The configuration is started. The green traffic light icon ((LED)) indicates that the configuration is running and collecting data from the control system.
Chapter 4

Analyzing FactoryTalk Historian Classic Data

FactoryTalk Historian Classic provides a graphical environment in which to analyze manufacturing process data. This chapter will help report designers understand how to use FactoryTalk Historian Classic to create and view RSBizWare reports containing time-series charts; bar, pie, and line charts; and tables. We will discuss the parts of a report, look at the sample reports that can be installed with the software, create a report based on the sample data, and discuss the creation of more complex reports. FactoryTalk Historian Classic must be set up by the RSBizWare administrator before you can start to create reports using real data.

Create a New RSBizWare Report

In RSBizWare, a report is a complete, formatted document that is made up of one or more report objects that have been placed in an HTML document along with text, graphics, and hyperlinks. A report, saved as an .htm file, is created and edited using the Configuration Console with a FactoryTalk Metrics Author license. RSBizWare reports can also be edited using Web-authoring tools such as Microsoft FrontPage.

An RSBizWare report object shows the data from a database table or view in a meaningful graphic or tabular presentation. The report object defines how the data is to be shown to the user. It defines both the visual representation of the data (e.g., pie chart, bar chart, table) as well as the data sorting and summarization.

The data for the report object comes from an RSBizWare report data source. A report data source is a connection to a table or view within the RSBizWare database or an external database.
The data in the report object may be restricted by a query (a filter), made up of one or more search criteria, that determine which records from the report data source will be shown. The use of a filter is optional.

To create a new, blank report:

1. Open the Configuration Console.
   A blank report page appears.

To add a title, a picture, and a hyperlink:

1. Click the report area, and type a title for your report, e.g., My Company Web Page.
   Select the title, and then, on the Report Formatting toolbar, change the title font to Arial, and the font size to 18.

2. On the Formatting Toolbar, click to align the text to the center of the page.
3. Click next to the title (its selection is canceled), and then press Enter.
4. Right-click the report area, and then click Insert Image.
   The Picture dialog box appears.
5. Next to the Picture Source box, click Browse to select the picture that you want to add to the report.
6. In the Alternate Text box, type a description of the image.
The alternate text appears as a tooltip when you point to the image.

7. Under **Layout** and **Spacing**, set the display properties of the picture.

![Picture Dialog Box]

8. Click **OK**.

The logo appears under the title.

![My Company Web Page]

9. Click the image, and then on the **Insert** menu click **Hyperlink**.

The **Hyperlink** dialog box appears.

10. In the **URL** box, type the address of the page which will open when you click the image.
11. Click **OK**.

**TIP** You can also add a hyperlink to a text. To do so, select the text, and then, on the **Reports Insertable Items** toolbar, click . Then, repeat step 10.

12. On the **Report Formatting** toolbar, click to see, how the report will look like as a web page.

When you point to the image, the alternative text will appear.

13. On the **Report Formatting** toolbar, click to go back to editing your report.

**Save the Report**

RSBizWare reports are saved as HTML documents on the Information Services Manager computer to which your Configuration Console is connected. They appear in the Report Explorer tree.
To save the report:

1. On the File menu, click Save Report As.
   
   The Save Report As dialog box appears.

2. In the Report Name box, type a name for your report file.
   
   In this example, the name is My Company Report.

3. Click Save.
   
   The report appears in the Report Explorer tree.

Add a Saved Report Object to Your Report

The Configuration Console allows you to view report objects that other users have created and to add them to your report. For this tutorial, we will add a saved report object that was created when the sample data was loaded.

1. With the report open in the work area, place your cursor in the report where you want the report object to appear.

2. On the main menu, select Insert > Existing RSBizWare Report Object. The following message appears.

   configure console

   Would you like to author this Report Object as 'admin' and connect to 'localhost'?

   Yes  No

   Each report object on a report can connect to a different Information Services Manager in your organization. Therefore, before you continue, you must identify the server to which this report object will connect.
Click **Yes** to accept the default user name and server. Click **No** to connect to a different server and display the login dialog box where you provide the credentials and the server that you want to use to author the report object.

For this tutorial, click **Yes** to accept the default user name and server. The **RSBizWare Report Object Properties** dialog box appears.

3. Use this dialog box to select the report object that you want to insert in your report.

![RSBizWare Report Object Properties dialog box](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Data Source</td>
<td>The list of report data sources from which the data will be shown in the report object and to which you have been granted permissions.</td>
</tr>
<tr>
<td>Report Object</td>
<td>The list of available report objects, grouped by the report data source from which they get their data. When you select a report data source, the list of report objects is refreshed to show only the report objects that are based on the selected report data source.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>The list of available filtering criteria.</td>
</tr>
<tr>
<td>Manage Report Objects</td>
<td>The button for displaying the Configure Report Data Sources, Report Objects and Filters dialog box.</td>
</tr>
</tbody>
</table>
| Select Which Toolbars to Show options | Select the check box near the toolbar name which you want to display on the report. The check boxes allow you to add toolbars to the report object. The end users of your report will use these toolbars to adjust the report object to suit their needs. The following toolbars can be selected:  
  • General  
  • Time Selection  
  • Status Bar  
  • Report Data Source  
  • Report Object  
  • Filter |

4. From the Report Data Source list, select FactoryTalk Metrics Workcell History. This is the data that will be shown in the report object.

5. From the Report Object list, select Workcell History.

6. For this example, we will not select a filter, so leave the filter list blank.

   **NOTE**  
   Filters are grouped by the report data source for which they have been created.

7. Select the Status Bar check box. This will cause a status bar to display at the bottom of the report object. Because each report object on a report can connect to a different server, the status bar will indicate the user and server to which the report object is connected at run time.

8. Click OK to add the report object to the report. The report object is shown as a simple box outline.

9. Double-click inside the box outline to see the table, and click Refresh. To populate the report object with data, click the Refresh button. Your report object should look similar to the following:
At run time, the RSBizWare report objects on your report will attempt to connect to an Information Services Manager to access the production data necessary to draw the chart, bar graph, etc. The connectivity settings for each report object specify how they will connect to the Information Services Manager. When the report user attempts to view an RSBizWare report that contains multiple report objects with different connectivity settings, the report users may be required to log on multiple times before they can see the report.

To avoid repetitive logons on a report, you can set your report objects to use **Global Credentials**. Global Credentials use a session logon to connect to a report object. With a session logon, the user is prompted for user name and password once for each server that is encountered. After the user’s credentials (user, password) have been specified for a server, those credentials are available to any subsequent report object that is running on that client computer, is using the **Use Global Credentials** option, and is attempting to connect to the same server. The session logon that is established will remain active until the user specifically logs off, the credentials expire, or the client computer is rebooted.
To enable a report object to make use of a session logon, the report object must be configured to use Global Credentials.

To configure a report object to use Global Credentials:

2. Click the Runtime Settings tab.

The Runtime Settings tab enables you to specify how the user will connect to the server that you selected when you inserted the report object. When you are configuring the server connection settings for a report object, you have the following options:

- **Use Global Credentials**
  
  This is the default option. Select this option if you want to use a session logon to connect to this report object.
Chapter 4 Analyzing FactoryTalk Historian Classic Data

- **Require user to login**
  
  Select this option if you want to require the users to provide their user name and password to access this report object. More than one report object on a report with this option selected will require the user to log on multiple times.

  **NOTE** Remember that any users who will be viewing the report must have access to the report data source, report object, and filter or they will not be able to see the report object.

- **Use RSBizWare Server Connection**
  
  Select this option if you want to specify the RSBizWare Server Connection that this report object will use when the user views the report at run time. You will only be able to select from Server Connection objects that are configured to use the same RSBizWare server that you selected when you added this report object to the report.

  **NOTE** This option is provided for backwards compatibility only. It is recommended that you use Global Credentials in place of RSBizWare Server Connection objects.

- **Use the following User and Password**
  
  Select this option if you want to specify at design time the user name and password that the report object will use when the user attempts to view the report object at run time. The advantage of choosing this option is that the user will not have to login to view the data.
By selecting this option, you are granting the specified user’s application privileges to the runtime user for this report object. Because the Save Report Object Contents to File, Add Time-Series Comment, and Edit/Delete Time-Series Comment application privileges allow action on report objects, it is important to consider whether the specified user has these privileges and whether you want the runtime user to have these privileges.

If you use this option across many report objects and the security policy for the user is very strict (that is, the password must be changed frequently), you will need to change the password setting separately for each report object. Consider using a less strict security policy (such as never requiring the password to be changed) for this user. For more information on security policy, consult the RSAssetSecurity documentation.

For this tutorial, make sure the **Use Global Credentials** option is selected.

3. Click **OK** to close the dialog box and save your changes.

You will be adding more report objects to this report. If you want the rest of the report objects on this report to use Global Credentials, you will need to specify this option for each report object when you insert the report object.

**Create a New Chart**

An important feature of the Configuration Console is the ability to create bar, pie, and line charts from data stored in a report data source. The purpose of this tutorial is to walk you through the steps that are necessary to create a chart with the New Chart Wizard. For this tutorial, you will use the Historian Data Point View report data source to create a chart showing the average running time per hour for work cells. This tutorial will also demonstrate how to create a prompt-at-runtime filter so that the end-user of the report can choose the work cells that will be charted. Your chart will look similar to the one shown below.
The following table shows a representation of the data we will be charting.

We will be creating a chart with a bar for each data point; therefore, the Description field is the series. Notice that one column in our table (Description) contains all of the data point descriptions, and the data for the data points is organized in rows. Each row contains the data value (Value) and the time stamp (TimeStamp) for each
data point. This will be important to remember when we are using the New Chart Wizard.

Place your cursor where you want the chart to appear in the report and select Insert > Chart to display the authoring user name and server prompt. Click Yes to accept the default user name and server. The New Chart Wizard will display. This wizard will lead you through the process of creating a new chart for your RSBizWare report.

Step 2: Select the Data On Which To Report

The first step in the New Chart Wizard is to select the report data source containing the data that we want to chart. The Report Data Source list contains the report data sources for which you have the appropriate permissions. Select Historian Data Point View from the list and click Next to continue.

Step 3: Choose a Chart Type

Next, we need to specify the type of chart that you want to create. The vertical bar chart is the default. Click Next to accept the default and continue.

Step 4: Describe the Data

In the data configuration step, you need to describe the data to the Chart Wizard. Recall that the data table data is organized in rows for each work cell (series). This corresponds to the example table shown in the Chart Wizard for the Rows option.
Chapter 4  Analyzing FactoryTalk Historian Classic Data

If the data points ID or descriptions If the series values (work cell descriptions) were in the column headers of the table and the Running Seconds values for each work cell were listed in the column for that work cell, this would be an example of a table where the series is in columns. For this type of table, you would select the Columns option.

However, since you have determined that the data is in rows, make sure the Rows option is selected and click Next to continue.

**Step 5: Select Summary or Detail**

In this step, you must decide whether you want to chart all of the values from the table or if you want to apply aggregate functions to the values. Since you want to summarize a field in the chart (find the average running time for each hour of the day), accept the default Summary option and click Next to continue.
Step 6: Select the Fields To Be Charted

In the Chart Fields step, we select the fields from the report data source that will be shown in the chart. This dialog box would look different if we had selected the Columns option in the Data Configuration step of the wizard.

1. Since we want to have a bar for each workcell and we want the names of the workcells to appear in the legend, select Description from the LEGEND list.

2. Select the Value field from the VALUE list. This is the field that will provide the values for the height of the bars.

3. When you selected the Value field from the VALUE list, COUNT(Running Seconds) was added to the list at the bottom of the dialog box. To change the function that is applied to the field, select the COUNT(Value) field in the list, click Function, and select AVG from the shortcut menu.

   This action changes the function from COUNT(Running Seconds) to AVG(Running Seconds). The AVG(Running Seconds) function will return the average running time value for each workcell.

4. Now we will add Hour labels to the X-axis. This will allow us to group the average running time values for the workcells by hour. Select TimeStamp from the X-Axis list.

5. When TimeStamp is added to the list at the bottom of the dialog, it has no formatting applied to it. Since we only want to see the hour portion of the timestamp in our chart, we must apply the HOUR format to the timestamp. To change the
format to HOUR, select TimeStamp from the list, click Format, and select HOUR from the shortcut menu.

6. Click Next to continue.

**Step 7: Enter the Chart Title**

The Report Object Name dialog box appears. You must provide a unique name for the report object. The name you enter here will appear at the top of your new chart and will also be the name for this chart when it is saved as a report object for future use.

1. For this tutorial, enter Historian Data Point View AVG(Value) in the Report Object Name box.

2. Click Next to continue.

**Step 8: Filter the Data**

The Filter dialog box appears. Now you will create a filter that will specify which records will be charted. Since you only want to chart the values for certain work cells, you will need to filter out the work cells that you do not want to chart.

There are two types of filters that you can create:

- The static filter, where you provide all of the filter values when you create the filter.
- The “prompt-at-runtime” filter which allows the user to select the filter values every time the filter is used.

For this tutorial, you are going to create a prompt-at-runtime filter that allows the users to select the work cells that they want to report on when the report is run.

**NOTE** Prompt-at-runtime filters cannot be used with report objects that will be scheduled.
To create a new filter:


2. Enter the name Data Point Filter in the Edit Filter Name box.

3. A filter is made up of one or more search criteria. For this filter, you will create a single criterion. Click Add Criterion. The Search Criterion dialog box appears.

4. Select the Description field from the Field tree and select the = operator from the Operator list.

5. Select the Select from a list of existing values for this field check box. This creates a list of unique values from which the user can pick report values.

6. Select the By prompting user when filter is run check box. This makes this a prompt-at-runtime filter.

7. Select the Allow multiple selection from list check box. This allows the user to select more than one work cell from the list of values that is created.

8. Select the Required (Must be supplied when filter is run) check box. Doing this will require the user to specify a filter value when the report object is run.
9. Click OK to return to the Configure Filter dialog box. After you have completed these steps, the Configure Filter dialog box should look like the example below.

10. Click OK to return to the New Chart Wizard.
Step 9: Insert Your New Chart Into the Report

Now that you have selected the report data source, created the chart report object, and created a prompt-at-runtime filter, you are ready to insert the chart into the report.

To insert the chart into the report:

1. Click Finish to add the chart to the report. The chart is shown as a simple box outline.
2. To ensure that the filter is properly associated with the report object, right-click the report object and select Properties.
3. In the Report Object Properties dialog box, select the Runtime Settings tab and select the Data Point Filter from the Default Filter list.
4. Click OK to return to the report object.
5. Double-click inside the box outline to see the chart.

Click the All Time Range button on the Time Selection toolbar, set the time range to 4/19/2005 9:00 AM to 4/19/2005 12:00 PM, and click Refresh. When you refresh a report object that contains a required prompt-at-runtime filter, the Runtime Report Criteria dialog box will appear. This is the prompt that was created by the prompt-at-runtime filter. This dialog box allows the users of your report object to specify the values that will be displayed in the report object.

NOTE If you did not select the Required check box in Step 8, the preceding prompt would not appear.
6. For this tutorial, hold down the **Ctrl** key on your keyboard and select all of the **Injection Molding** data points from the list.

7. Click **OK** to display the chart with the data points that you selected.

Refer to "Customizing RSBizWare Charts and Tables (page 87)" for information on how to further customize your chart by changing the title or bar/line colors.

**Create a New Text Report Object**

The Configuration Console gives you the ability to create a text report object (or table) on your report that displays the data from a report data source. The purpose of this tutorial is to walk through the steps that are necessary to create a table in your report. For this tutorial, you will use the Historian Data Point View report data source to create a table showing the average value for data points. Your table will look similar to the one shown below.
**Step 1: Start the Text Report Object Wizard**

To start the Text Report Object Wizard:

1. In the Configuration Console, place your cursor where you want the table to appear in the report.
3. Click Yes to accept the default user name and server name. The Report Wizard appears.
4. Click Next.

**Step 2: Select the Data On Which To Report**

To select the data that you want to include in the table:

1. The Report Data Source list box contains the report data sources for which you have the appropriate permissions. Select Historian Data Point View from the list.
2. The Report Data Source Fields list contains the fields that are available for use in your table. Select the Description.
Chapter 4 Analyzing FactoryTalk Historian Classic Data

**Time**Stamp, and **Value** fields and then click to add the selected fields to the **Fields in report** list.

Each field that you add to the list will be a column in your text report object.

3. Click **Next**.

**Step 3: Group the Records**

The **Grouping Levels** dialog box allows you to specify how your table will be grouped.

1. The fields that we added to the table are listed in the box on the left side of the dialog box. We can group by any of these fields. For this tutorial, let’s group the records by **TimeStamp** and data point. Select the **TimeStamp** and **Description** fields and click the right arrow button (>) to add fields to the **Grouped fields** list on the right side of the dialog box.

2. We want to force the report to group the records by **Part** first, so let’s make sure the **TimeStamp** field is at the top of the **Grouped fields** list. If it is not, select **TimeStamp** and click the up arrow Priority button (^) until **TimeStamp** is at the top of the list.
3. Since we want to group the records by the hour portion of the timestamp, select \textbf{TimeStamp} in the box on the right and click the \textbf{Grouping Interval} button. The \textbf{Format Field} dialog box is displayed. Select the HOUR format and click \textbf{OK} to return to the Report Wizard.

4. Click \textbf{Next} to continue.

**Step 4: Sort the Records**

The Sort Order dialog box allows you to specify the order in which the columns will be sorted and to calculate totals for columns. Since we chose to group by TimeStamp and Description, those columns automatically have a sort order applied to them.

1. To calculate the average downtime value, select the \textbf{AVG} check box in the \textbf{Downtime Seconds} row.
The weighted average (WAVG) function is an average that takes into account the proportional relevance of each component (typically over time), rather than treating each component equally. Weighted average can be used in any table of information where the values of a particular column should be given more or less importance based upon the values of another column. The weighted average function is ideal for calculating a time-weighted average OEE value for multiple activity areas. See the Weighted Average topic in online help for additional information.

2. For this table, you are not interested in showing the individual detail records that make up the average downtime; you want to see only the average downtime per work cell values. Select the Summary Only option at the bottom of the dialog box.

3. Click Next to continue.

**Step 5: Format the Table**

The Format Style dialog box allows you to control the appearance of the table.

1. The Report Style section of the dialog box lets you choose the color scheme that will be applied to the table or to create a custom style. For this tutorial, select the Access Northwind
Invoice style from the Report Style list. A sample of the style is displayed in the preview window to the right of the list.

2. The Styles by Field section of the dialog box allows you to set display formats for the individual fields. For this example, specify the time formatting that is applied to the AVG(Downtime Seconds) field. Select the field from the list box and click Customize Selected Field. The Customize Report Styles dialog box appears.

3. Click the Number tab.

4. Click the Apply the following formatting option and ensure that No. of digits after decimal is set to 2.

5. Click OK to accept the values and return to the Report Wizard.

6. Click Next to continue.
Step 6: Name the Report Object
On the Report Object Name page, you need to provide a unique name for the report object.

1. For this tutorial, enter Historian Data Point View Table.
2. Click Next.

Step 7: Filter the Data
On the Filter page, you can use the same filter that you created for the chart, or you can create a new one. For this tutorial, use the one created before.

To filter the data:

1. Click Data Point Filter from the Filter list.
2. Click Next.

Step 8: Insert Your New Table Into the Report
You have already selected the report data source, created the table report object, and selected a filter. The Finish page appears.

To insert your new table into the report:

1. Click Finish to insert the report object.
2. To ensure that the filter is properly associated with the report object, right-click the report object and then select Properties from the shortcut menu.
3. On the Report Object Properties dialog box, select the Runtime Settings tab and select the Workcell Description Filter from the Default Filter list.
4. Click OK to return to the report object.
   The table is displayed as a simple box in the report.
5. Double-click the box outline to view the table. As you did with the chart, click the Time Range button on the Time Selection toolbar and set the time range to 4/19/2005 9:00 AM to 4/19/2005 12:00 PM. Click Refresh to run the report object.
One of the primary features of FactoryTalk Historian Classic is the ability to analyze time-series data. Any data value that is collected over time is time-series data. A temperature or pressure value that is collected over time is an example of time-series data. This tutorial will help you understand how to use FactoryTalk Historian Classic to analyze time-series process data.

To create a time-series chart on your report, place the cursor in the report where you want the chart to appear and select **Insert > Time-Series Trend Chart** from the main menu. When the authoring user name and server prompt is displayed, click **Yes** to accept the defaults. The Configure Time-Series Report Object dialog box is the starting point for creating our time-series chart.
Chapter 4  Analyzing FactoryTalk Historian Classic Data

Step 2: Name the Report Object

We must provide a unique name for our time-series chart. For this tutorial, type Time-series Chart in the Report Object Name box and select the Include report object name as title on chart check box. This will cause the name to be shown at the top of the time-series chart. If you clear this check box, the chart title will default to “Time-Series Analysis.”

Step 3: Add Reporting Tags

Now, we must select the reporting tags that will be trended on our time-series chart. A reporting tag is a field within a database table or view that provides the values that will be charted on our time-series chart.

The Reporting Tags Available list on the left side of the dialog box contains the tags that can be added to the chart. The Reporting Tags Selected list on the right side represents the tags that will be
shown on the time-series chart. The tabs at the top of the *Selected* list represent the Y-axes that are shown in our chart. For example, if our chart contains two Y-axes, there will be two tabs at the top of the *Reporting Tags Selected* list. Since we have just created this time-series there is only one tab.

For this tutorial, let’s chart the FactoryTalk Historian Classic Demo – Flow Rate reporting tag.

1. Expand the *Reporting Tags by Report Data Source* item in the *Reporting Tags Available* list and find and expand the *Historian Data Point Default* item. Finally, select the *FactoryTalk Historian Classic Demo – Flow Rate* item.

2. Click the > button to add the selected reporting tag to the *Reporting Tags Selected* list.

### Step 4: Apply an Analysis Tool

When creating a time-series chart, you may want to find the average value of a reporting tag or apply some other analysis tool to the tag. The Analysis Tools column in the Reporting Tags Selected list shows the analysis tools that have been added to the reporting tags in the chart.

1. To apply an analysis tool to a reporting tag in the time-series chart, we will need to add the reporting tag to the list a second time. Select the reporting tag from the Available list and click the > button to add the tag to the Selected list again.

2. Now click the <None> text in the Analysis Tools column for the second instance of the reporting tag. A list containing the available analysis tools will display. Open the Statistics folder and select the mean analysis tool from the list.
Chapter 4  Analyzing FactoryTalk Historian Classic Data

TIP
If you want to use the Configuration Console to chart a calculation that is unique to your process, see "Customizing RSBizWare Charts and Tables (page 87)."

Step 5: Customize the Chart Legend

1. Click the Legend tab. This tab enables you to specify the type of legend that will be shown on the time-series chart. For this tutorial, accept the default Authoring Legend option.

The Classic Legend is the traditional legend with a color sample and display name for each reporting tag or analysis tool that is shown on the chart. If you use the classic legend, report
users will not be able to change pen colors, line thicknesses, or other chart styles.

The **Authoring Legend** is a table that contains the properties of the chart that you specify here. Users of your report will be able to customize their view of the chart by changing the values associated with these properties. This legend provides the maximum amount of flexibility for your report users.

2. The Fields in this Legend list contains the names of the chart properties that will be shown on your Authoring Legend. For this tutorial, accept the defaults.

---

**Step 6: Insert Your New Chart Into the Report**

Click **OK** to add the time-series report object to the report. The time-series chart will display in the report, but you will not see any data in the chart. This is because the default time range for a time-series chart is “the past 2 hours,” but the sample data was collected between June 30, 1999 11:01 AM and June 30, 1999 1:31 PM. In the next section of the tutorial, we will learn to control the time range for the data that will display in the chart.

**Step 7: Adjust the Time Range**

When you create a new chart or table that is based on a time selection-enabled report data source, the **Time Selection** toolbar shown below will automatically appear at the top of the time-based report object. The **Time Selection** toolbar acts like a filter on the timestamp field that was designated for time selection when the report data source was created.

![Time Selection Toolbar](image)

The default time selection filter is the past 2 hours. Use the Time Selection toolbar to define time ranges, start and end date/times, or time increments for your time-based report objects. The Time Selection toolbar provides the following buttons:

- The **Refresh** button re-executes the report object based upon the selections made in the Time Selection toolbar. When
you make a change to the settings on the Time Selection toolbar, you must click **Refresh** to view the change.

- The **All Times** button is used to show all data that has ever been collected, without specifying the start and end times. This is especially useful if you do not know the start and end date for which data has been collected.

- The **Time Range** button enables you to specify the start and end times to which the data will be restricted. Use this button if you want to report only on data between a specific beginning and ending time.

- The **Time Span** button restricts time to the past by a unit of time. This button is useful if you want to show all data from the past 24 hours, the past 7 days, or the past year. When you use this button with an auto-refresh chart and data that is currently being collected, the chart will continue to refresh with the current date/time as the end time.

- The **Past Time from End Time** button uses a unit of time before the specified end time. For example, this button is useful if you want to show all data from the week before August 2, 2005.

- The **Future Time from Start Time** button uses a unit of time after the specified start time. For example, this button is useful if you want to show all data from the week after August 2, 2005.

To change a date or time on the Time Selection toolbar, use the drop-down arrow to the right of the field or type a value directly in the field.

For our tutorial example, click **All Times** and then click **Refresh**. Your table should look similar to the following:
When you save your report, the settings that you specified on the Time Selection toolbar during report authoring will be saved with the chart. These become the defaults for runtime users and they are also used when you schedule the report object to be run at a later date. Scheduling report objects and reports is discussed in Advanced Reporting Topics (page 97).

Although the Time Selection toolbar settings are used when you schedule the report object, the scheduled output does not show the Time Selection toolbar. To show the start and end times that are being used in scheduled report objects, add start- and end-time dynamic text fields to your report object. Refer to the Add Dynamic Text Fields To a Report Object topic in the online help for the instructions to perform this task.

Step 3: Add Reporting Tags

Now, let’s suppose we want to show the Flow Rate reporting tag and the SUM(Flow Rate) analysis tool on a single chart. These two reporting tags have very different value ranges; therefore, if we chart the two reporting tags on the same Y-axis, the scaling of the graph for SUM(Flow Rate) may distort the graph line for Flow Rate.

To isolate reporting tags or analysis tools with varying value ranges, we can display one reporting tag on the original Y-axis, create a second Y-axis on the same chart, and display the analysis tool on the second Y-axis.
1. Click the chart in the report work area and select View > Properties from the main menu. The Configure Time-Series Report Object dialog box will appear again.

2. First, let’s remove the analysis tool that we added before. We will not need it for this example. Select the FactoryTalk Historian Classic Demo – Flow Rate reporting tag that has the mean analysis tool added to it and click the < button to remove it from the Reporting Tags Selected list. You should still have a single instance of the FactoryTalk Historian Classic Demo – Flow Rate reporting tag in the Reporting Tags Selected list.

3. Click the Axis tab to display the Time-series Axis dialog box. This dialog box allows you to control the X- and Y-axis for the time-series chart.

4. At the bottom of the dialog box, click the Add Axis button to create a second Y-axis for the chart. The second Y-axis (Y2) will appear as a second row in the Y-axis table at the bottom of this dialog box.
5. Click the **General** tab. You will notice that there are now two tabs at the top of the **Reporting Tags Selected** list. The **Y2** tab represents the second Y-axis on the chart. Click the **Y2** tab.

6. In the **Reporting Tags Available** list on the left, locate the FactoryTalk Historian Classic Demo– Flow Rate reporting tag and click the > button to add the reporting tag to the **Y2** tab. Now add the SUM analysis tool. You will find the tool in the **Cumulative Statistics** folder of the analysis tools list.

7. Click **OK** to close the dialog box and display your chart. Double-click the report object, click the **All Times** button, and click the **Refresh** button. Change the line color for the **Y2** axis to **Green**. Your chart should look similar to the image below.
Chapter 4 Analyzing FactoryTalk Historian Classic Data

You will notice that the Y1 axis is shown to the left of the chart and the Y2 axis is shown to the right of the chart and that the value ranges for the two lines are very different. If you had placed the SUM tool on the same Y-axis with the Flow Rate, the large range of values for the SUM tool would have distorted the FactoryTalk Historian Classic Demo – Flow Rate line, making it appear deceptively flat, as shown below.

**Step 9: Remove a Reporting Tag or an Analysis Tool**

To remove a reporting tag or an analysis tool from your time-series chart without opening the Configure Time-Series Report Object dialog box, right-click the reporting tag (or analysis tool) in the Authoring legend and select **Remove Reporting Tag** from the shortcut menu that is displayed. The reporting tag or analysis tool is removed from the chart and the chart is refreshed.

**Create a Simple Batch/Event Chart**

Let’s suppose that we are collecting the water temperature from a process. The process allows the user to enter a Batch ID, specify the kettle (or unit) in which to brew the coffee, and select a coffee recipe. These batch parameters are collected from the control system with FactoryTalk Transaction Manager transactions and are stored in the BatchSummary table in the RSBizWare database.

We would like to be able to report on the water temperature from the process by simply selecting one of these batch parameters, such as the Batch ID that uniquely identifies the batch, rather than needing to specify the start time and end time. Additionally, we would like to be able to specify more than one batch to be displayed on the
time-series chart in order to see how the batch performed as compared to other similar batches or perhaps compared to an ideal batch.

**NOTE**  This example is for simple batch reporting only. For more information on setting up the batch parameter data collection, refer to the Rockwell Automation knowledgebase article titled “Simple Batch Reporting using RSBizWare Historian 5.0.” For a fully-integrated S88-compliant batch reporting system, FactoryTalk Batch and FactoryTalk Historian for Batch are recommended.

1. To create a time-series chart on your report, place the cursor in the report where you want the time-series chart to appear and select **Insert > Time-Series Trend Chart**. The authoring user name and server prompt is displayed. Click **Yes** to accept the default user name and server.

2. The Configure Time-Series Report Object dialog box will display. On the General tab, name the report object **Batch Analysis** and select the **Include report object name as title on the chart** check box.

3. Add the Water Temperature reporting tag to the time-series chart by expanding the **Reporting Tags by Report Data Source** item, expanding the **Historian Data Point Default** item, selecting the **Water Temperature** tag, and clicking the **>** button.

4. You can configure the time-series chart to prompt automatically for the batch parameters by selecting the **Prompt for Batch at runtime** check box at the bottom of the dialog box. The user will be prompted automatically each time this report object is displayed.

5. Now, let’s change the Authoring Legend so that it lists the batch parameters for the batches displayed in the chart. Click the Legend tab. Make sure the Authoring Legend option is selected. Select **User Field 1**, **User Field 2**, and **User Field 3** in the Authoring Legends Field list and click the **Add >** button to add the fields to the Fields.
in this Legend list. Select the three User Fields in the Fields in this Legend list and use the arrow buttons to move these fields up so that they immediately follow the Reporting Tag and Units fields.

7. To display the relative time of each batch, repeat the same procedure to add the **Relative Time Start** and **Relative Time End** fields to the Authoring Legend. Use the arrow buttons to position these fields after User Field 3.

8. Click **OK** to close the dialog box and display your chart.

9. Double-click the report object and make sure the Time Selection toolbar is showing a date range that contains data for the selected reporting tag. This step is important. If your chart is not showing data, the Batch Prompt dialog box that will be displayed in the next step will not show any batch prompt fields. In this example, we can click the **All Times** button on the Time Selection toolbar and then click the **Refresh** button to display the line that represents the coffee temperature data.

10. This dialog box allows you to select one or more batches for which you want to compare data without the need to specify the start time and end time for each batch.

In the first row of the Batch Prompt grid, select the **Water Temperature** reporting tag from the list of reporting tags that have been added to the chart. Using the subsequent fields, select the batch parameters to identify the batch you would like to display. For this tutorial, select **XYZ100** from the
Batch ID field. If the selected value for a batch parameter field is enough to identify the batch uniquely—as is the case with the Batch ID field for the XYZ100 batch—the fields that follow will be filled in for you.

**TIP**
The first batch selected will drive the time axis (X-axis) on the time-series chart. So for example, if you wish to compare an actual batch XYZ100 with the IdealBatch, you should select batch XYZ100 first so that the X-axis reflects the time range when the actual batch was run.

11. In the second row of the Batch Prompt, again select the **Water Temperature** reporting tag from the list of reporting tags and select the batch parameters for the second batch you wish to compare, in this case, **XYZ101**.

12. Click **OK** to return to the chart in your report.

The batch parameters as well as the start and end times for both batches are displayed in the Authoring Legend. Notice that the time axis is controlled by the first batch selected. You will notice that the values along the X-axis are actual clock times. If you want to see the times that the data values were collected relative to the start of the batch (for example, where the data value at 00:00:04 on the X-axis represents data that was collected 4 seconds after the start of the batch), select the Elapsed Time option on the Axis tab of the Configure Time Series Report Object dialog box.

---

**Add a Comment to a Value, X-axis, or Y-axis on a Time-series Chart**

1. Time-Series Reporting Tag Annotation allows you to select a value in a time-series chart in the Configuration Console or the Quick Web and associate a comment with that value. There are three different types of Time-Series Reporting Tag Annotations: value comment, X-axis comment, and Y-axis comment.

2. For example, suppose you noticed a spike in the data on the time-series chart that was caused by an operator who accidentally kicked out the power cord on the machine from which the data was being collected. When report users see this chart, they will want to know what caused the spike. Tag
annotation will enable you to supply information about this spike to other report users.

**NOTE** You must have the Add Time-Series Comment application-level privilege to perform tag annotation. An Author license is not required.

**Value Comments**

A value comment is a comment that is associated with a specific value within a reporting tag. The value comment provides an explanation of why the value of a process parameter has deviated from the norm. For example, a value comment will enable us to document the spike in our time-series data caused by the power interruption.

Right-click a point on the Batch Analysis chart from the preceding section and select **Add Comment > Value** from the shortcut menu to display the Value Comments dialog box. It will enable you to enter a comment for a single value in the time-series chart.

1. The Reporting Tag list will default to the reporting tag nearest to where you right-clicked in the time-series report object. Select the reporting tag to which you want the comment to be applied.

2. The Value field will default to the value nearest to where you right-clicked in the time-series chart. Select the exact value to which you want the comment to be applied.
3. Enter the text of your comment, which is restricted to 255 characters.

4. Click OK to save your comment and close the dialog. The comment is saved in the reporting tag along with the date/time when the comment was added and the ID of the user who entered the comment.

On future displays of this reporting tag, a numbered yellow marker will indicate the annotated value. When the report user hovers the mouse pointer over the annotated value, a tool tip will display the text of the comment. The value comment will show up in every report object that displays the selected reporting tag value.

**X-axis Comments**

An X-axis comment is a comment associated with a specific date/time on the chart and is not associated with a reporting tag. The X-axis comment provides a date/time limit on the time-series chart. For example, when tracking the flow rate, an X-axis comment allows you to indicate the start of the batch.

1. Right-click the start time of the batch in the chart and select Add Comment > X-Axis from shortcut menu to display the X-Axis Comments dialog box. This dialog box will allow you to enter an X-axis comment for the time-series chart.
2. The Timestamp field will default to a date and time nearest to where you right-clicked in the time-series chart. Select the exact date and time to which you want the X-axis comment to be applied.

3. Use the lists in the Line Properties area to specify the color, style, and thickness of the line that will be used to indicate your start of batch.

4. Enter the text of your comment, which is restricted to 255 characters.

5. Click **OK** to save your comment and close the dialog box. The comment is saved in the report object along with the date/time when the comment was added and the ID of the user who entered the comment.

On future displays of this time-series chart, a vertical line and numbered yellow marker will indicate the annotated value. When the report user hovers the mouse pointer over the annotated value, a tool tip will display the text of the comment. The X-axis comment will be displayed only on the report object where it was created.

### Y-axis Comments

A **Y-axis comment** is a comment that is associated with a specific value on the chart and is not associated with a reporting tag. The Y-axis comment provides a value limit on the report object. For example, when tracking the temperature during a batch process, a Y-axis comment allows you to indicate the maximum acceptable temperature for the batch process.

1. Right-click the maximum temperature in the chart and select **Add Comment >Y-Axis** from shortcut menu to display the Y-Axis Comments dialog box. This dialog box will allow you to enter a Y-axis comment for the time-series chart.
2. The Value field will default to the value nearest to where you right-clicked in the time-series chart. Select the exact value to which you want the Y-axis comment to be applied.

3. Because time-series charts can have multiple Y-axes, you will be able to associate this comment with a specific Y-axis. Select the Y-axis with which you want to associate your comment.

4. Use the lists in the Line Properties area to specify the color, style, and thickness of the line that will be used to indicate your start of batch.

5. Enter the text of your comment, which is restricted to 255 characters.

6. Click OK to save your comment and close the dialog box. The comment is saved in the report object along with the date/time when the comment was added and the ID of the user who entered the comment.

On future displays of this time-series chart, a horizontal line and numbered yellow marker will indicate the annotated value. When the report user hovers the mouse pointer over the annotated value, a tool tip will display the text of the comment. The Y-Axis Comment will be displayed only on the report object where it was created.
Ad Comment As

While the ability to add comments is restricted by an application-level privilege, the Add Comment As menu item will be enabled for all users. The Add Comment As feature allows a second user to add comments without ending the first user’s Configuration Console or Quick Web session.

For example, if you are viewing a time-series chart in the Configuration Console or the Quick Web and you recognize a data value to which a comment needs to be attached but you have not been assigned the Add Time-Series Comment privilege, you can ask a supervisor or another user who has the privilege to add the required comment.

The second user will simply right-click the value in the chart and select Add Comment As > Value Comment from the shortcut menu. The Comment Login dialog box is displayed, prompting the user to enter his user name and password to create a temporary connection to the server. After he has obtained a temporary connection to the server, he can enter the required comment. When he presses OK to close the comment dialog box and save his changes, his user ID is stored with the comment text and his temporary connection to the server is terminated.

Export the Report to HTML

When you save your RSBizWare report to the Report Explorer, the report is saved on the Information Services Manager to which you are connected. If you want to open and edit your report in an HTML editor or make the page part of a website, you need to export the report to an .htm file.

To export the report to HTML:

1. On the File menu, click Export To File.
   The Save As dialog box appears.
2. Navigate to the location, in which you want to save the report.
3. In the File name box, type a name for the report file.
In this example, the name is **My Company Report**.

The name of the file and its location is displayed on the title bar of the Configuration Console.

You now have two copies of the report: one saved as an .htm file, and the other stored in the Information Services Manager.

The .htm file contains text and some RSBizWare ActiveX controls. You can edit it in an HTML editor.

### Load the Report From File

Once you modify your report in an HTML editor, you can import it to the Configuration Console.

**To load the report from an HTML file:**

1. On the **File** menu, click **Load from File**.
   
   The **Open** dialog box appears.

2. Find your report file, and then click **Open**.
   
   The report is displayed in the Configuration Console.

3. Save the file as an RSBizWare report (page 44).

4. The report is now available on the Information Services Manager computer.
Customizing RSBizWare Charts and Tables

This chapter will help you understand how to customize charts and tables that have been added to RSBizWare reports. For this example it is assumed that you have:

- An RSBizWare report containing chart and table report objects open in the Configuration Console.

A FactoryTalk Historian Classic Author license. Furthermore, it is assumed that you have Edit Report and Edit Report Object permissions for the report and the report objects with which you are working. The examples in this chapter use two of the report objects that we created in "Analyzing FactoryTalk Historian Classic Data (page 41)".

Customizing Charts

You can customize the appearance of the chart in your RSBizWare report by changing the styles used in the chart, the size of the legend, the font that is used in the title, the color of the background, and much more.
Chapter 5  Customizing RSBizWare Charts and Tables

NOTE
When you make modifications to a report object, all instances of the report object (such as those on other RSBizWare reports) will reflect the changes you have made.

Charts typically consist of three components: a title at the top, a chart in the middle, and a legend at the bottom. The default layout is fine for most charts, however, you can also change the layout of your chart if needed. Perhaps the legend would fit better in another place on the chart, or the legend should be resized because it is too small to show all of the legend keys.

A chart component must be in edit mode in order to be modified.

To set a chart component in edit mode:

1. Make sure your RSBizWare report is in design mode.
2. Click the chart.
   The edit mode on the chart is enabled, and the component will have eight resizing handles and a highlighted border, indicating that it is ready to be modified.
3. Click the individual chart components and put them in edit mode.
When you finish working with the chart component, click outside the chart to remove the resizing handles and highlighted border.

**Resizing a Component**

**To resize a component:**

1. Make sure that the sizing handles and highlighted border are visible around the component.
2. Point to one of the sizing handles, and when the cursor changes to ⇨, drag the handle until the component is the desired size.

**Moving a Component**

**To move a component:**

1. Make sure that the sizing handles and highlighted border are visible around the component.
2. Point to the highlighted border, and when the cursor changes to ↩, drag the component to the new location.

**Deleting a Component**

**To delete a component:**

1. Make sure that the sizing handles and highlighted border are visible around the component.
2. Right-click the component, and then click **Delete** or press the **Delete** key on your keyboard.

**Editing the Chart Title or Text Field**

**To edit a chart title or a text field:**

1. Make sure that the sizing handles and highlighted border are visible around the component.
2. Right-click the chart title or text field, and then click **Edit Text**.
   
   The **Set Text** dialog box appears.
3. Modify the text and then click **OK** to save your changes.
Changing Chart Component Properties

Examples of standard properties that you can change for chart components are border style and font style. In addition to the standard properties, each chart component type has some specific properties that relate only to its type. For example, the chart legend has properties that specify how the keys will be displayed within the legend.

To access the property page for a chart component:

1. Make sure that the sizing handles and highlighted border are visible around the component.
2. Right-click the chart component and then click Chart Object Properties.

Working With Chart “Pens”

When you create a chart, the bars, pie slices, or lines of the chart are drawn with a default style. To make the chart easier to read or more appealing to users, you can change the color, formatting, and size of the data series used. For example, you can change the thickness of the lines in your X-Y chart to make them easier to see.

To customize the chart styles:

1. Make sure that the sizing handles and highlighted border are visible around the component.
2. Right-click the line, bar, or pie slice that you want to modify, and then on the shortcut menu click the desired option. The options available vary depending on what component type (line, bar, or pie slice) your chart uses. If your chart has an authoring legend, you can also use the chart property fields added to the authoring legend to customize colors and styles.

Customizing Text Report Objects

When your RSBizWare report contains a text report object or table, you can interactively show/hide, resize, and rename the columns, change the grouping and sorting of the columns, and apply aggregate functions to them. These are shortcuts to features that are normally
Available in the properties dialog box of the report object. The shortcuts have been created to allow you to quickly change the look and format of the table.

Your RSBizWare report must be in design mode in order to be modified.

NOTE
When you make modifications to a report object, all instances of the report object (such as those on other RSBizWare reports) will reflect the changes you have made.

Show and Hide Columns

Some report data sources may contain so many columns that they cannot be shown easily in a table. If you are creating a table for a report data source with many columns, you can show only the columns with the information needed by the user.

To hide a column:

- Right-click the column that you want to remove from the table, and then click Hide Column.
The columns that are removed from the table can be added again later.

**To show a column that is not currently included in the table:**

- Right-click the table and then click **Insert Column > <Column name>**.

The column will be inserted to the right of the column that is selected.

---

**Resize Table Columns**

When you add a column to a table, it is assigned the default width. Sometimes, the default width is too large, resulting in excess white space, or too small, making the values wrap in the cells. The column-resizing feature allows you to adjust the column size as needed.

**To resize a column:**

1. Point to the grid line to the right of the column that you want to resize.
2. When the cursor changes to 

---

**Aggregate, Group, Format, Sort, Chart, and Rename Columns**

If you have selected the Interactive Grid style for your table, you can:

- Interactively add an **Aggregate** function column to the table.
- Change the grouping of the table records.
- Apply a format to the selected column.
- Change the sort order of the table.
- Rename the selected column heading.

If your table is not using the Interactive Grid style, you need to change the table style.
To change the style of the table to the Interactive Grid style:

1. Click the table, and then on the View menu click Properties. The Report Object Properties dialog box appears.
2. On the Advanced tab click Format.
3. The Global Report Object Formats dialog box appears.
4. On the Styles tab, in the Style drop-down list select Interactive Grid.
5. Click OK to return to the Report Object Properties dialog box.
6. Click OK to return to the report design mode.

Your table should resemble the following sample one:

<table>
<thead>
<tr>
<th>StateName</th>
<th>StationName</th>
<th>AVG(TimeInState)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(all)</td>
<td>(all)</td>
<td>(all)</td>
</tr>
<tr>
<td>FAULT</td>
<td>PACK_LINE1</td>
<td>0.95</td>
</tr>
<tr>
<td></td>
<td>PACK_LINE2</td>
<td>0.96</td>
</tr>
<tr>
<td></td>
<td>PACK_LINE3</td>
<td>0.95</td>
</tr>
<tr>
<td>PROD</td>
<td>PACK_LINE1</td>
<td>8.90</td>
</tr>
<tr>
<td></td>
<td>PACK_LINE2</td>
<td>8.90</td>
</tr>
<tr>
<td></td>
<td>PACK_LINE3</td>
<td>8.90</td>
</tr>
</tbody>
</table>

Aggregate

To apply the SUM aggregate function to a column, right-click the column header, and then click Aggregate > SUM.

The aggregate functions available on the menu vary from column to column. Only the functions that apply to a particular column are displayed. For example, it only makes sense to apply the SUM function to a numeric field.
To remove the aggregate function from a column, right-click the column header, and then click Aggregate > None.

**Group**

To group by field, right-click the column header, and then click Grouping > Group 1.

The table records are grouped by the selected column. Each time you click Grouping in the shortcut menu for additional columns, additional group numbers are added to the menu. This allows you to group by as many columns as displayed in your table.

To remove a grouping, right-click the column header, and then click Grouping > None.

**Format**

To apply a format to a column, right-click the column header, and then click Format > format style.

The format styles available on the menu vary from column to column. Only the formats that apply to a particular column are displayed. For example, it only makes sense to apply a month, day, and year format to a date field.

To remove a format from a column, right-click the column header, and then click Format > <None>. The column data will use the default format for the data type displayed in the column.

**Sort**

To apply an ascending (A to Z) order to a column, right-click the column header, and then click Sorting > Sort 1 > Ascending.

The table records are sorted by the selected column. Each time you click Sorting in the shortcut menu for additional columns, the additional sort numbers are added to the menu. This allows you to sort by as many columns as your table displays.

To remove the sorting order, right-click the column header, and then click Sorting > None.
NOTE You can also sort the data by clicking the column header; however, the new sorting order will not be saved when you save your table.

Chart

To change the axis on which the chart is graphed, right-click the column header, and then click **Chart > X-axis**.

To clear the chart axis, right-click the column header, and then click **Chart > None**.

Rename

To rename a column:

1. Right-click the column header, and then click **Rename**.

   The name in the column header is highlighted to indicate that it is ready to be changed.

2. Enter the new name for the column, and press the **Enter** key on your keyboard.

Quick Filter

If you have selected the Interactive Grid style for your table, each column in the table has a built-in quick filter below the column heading. The default quick filter for each column is *(All)*.

To create a quick filter:

1. Click the default quick filter to display a list containing all unique column values.

2. Select the value by which you want to filter.

   The table is trimmed using the value as the criterion.
Advanced Reporting Topics

In this chapter you will learn about the following:

- The Excel Add-in 97
- Scheduling Report Objects and Reports 101
- Analyzing Non-RSBizWare Data 110

The Excel Add-in

The Excel Add-in allows you to retrieve RSBizWare data (general reporting or grid data, and time-series data) directly in Microsoft Excel. After the RSBizWare data has been imported into Excel, you can use any of Excel’s analysis, charting, or scripting features to further process the data.

When you install the RSBizWare software on a computer, a custom RSBizWare toolbar is added to Microsoft Excel. The toolbar allows you to perform the tasks necessary to retrieve the RSBizWare data.

To specify the Excel and Information Services Manager connectivity settings:

1. On the RSBizWare toolbar, click to display the RSBizWare Connectivity Settings dialog box.
2. Type the name of the Information Services Manager to which your Excel workbook will connect.

3. Type the port number that you want to use for RSBizWare HTTP communications. The default number is 8080.

   **NOTE** Please contact your RSBizWare administrator for the specific port number that you should use.

4. Click **OK** to save your changes and close the dialog box.

A valid connection to the RSBizWare server is made and the RSBizWareSetup worksheet is created by the Excel Add-in. The worksheet contains the information required to retrieve data for the reports that you create in your Excel workbook.

To add and modify reports in your Excel workbook:

**NOTE** Each Excel workbook can contain up to 255 RSBizWare reports.

1. To create a new data grid report, select **Grid Data** in the **Report Type** list, and then click **Grid Data Parameters**.

   The **Grid Data Parameters** dialog box appears, in which you can specify the report parameters.
2. Click Save to save your report.

3. To create a new time-series report, select **Time-Series** in the Report Type list, and then click .

The Time Series Parameters dialog box appears, in which you can specify the report parameters.
4. Click **Save** to save your report.

5. To modify the parameters of a grid or time-series report, click the column defining the report in the **RSBizWareSetup** sheet, and then click ![image](image.png).

6. In the dialog box that appears, modify the desired parameters, and then click **Save**.

   **NOTE** To delete a report from the workbook, click **Delete** at the bottom of the dialog box.

7. To refresh the reports, click ![image](image.png).
The **Report Name List** dialog box appears.

8. Select the reports that you want to refresh, or select the **Refresh All Reports** check box.

9. Click **Update** to refresh the selected reports and close the dialog box.

10. Click **to save your workbook.**

### Scheduling Report Objects and Reports

The Configuration Console allows you to schedule tasks to be run at some time in the future. The scheduling feature allows the valuable information in the Configuration Console to be used by the entire company without the cost of a runtime user license. Any report in the system can be scheduled as a task. The results of the task can be saved to a file, sent to an e-mail address, or printed. With this capability, you can set the Schedule Manager to e-mail report objects to production supervisors every morning, or update your production statistics in an HTML document that is referenced by your Web server.
Schedule a Report Object

To schedule a report object to be run at a later time:

1. Open the Configuration Console.
3. Click Add. The Schedule Wizard appears.
5. Click Next. The Description and Frequency page appears.
6. In the Task Description box, type the description of the task that will be performed.
For this example, type *Workcell Production Scheduled Task*.

7. Under **Frequency**, select the desired option to specify the task frequency.

For this example, select **One Time**.

8. Click **Next**.

The **Single Execution** wizard page appears.

9. In the **Date** and **Time** boxes, specify the exact date and time of performing the task.

10. Click **Next**.
The **Delivery Method** wizard page appears.

**11.** Select one or more of the following distribution methods:

- **E-mail.** Select this option to e-mail the task results.
  - In the **To** box, type the e-mail address to which the results will be sent as an e-mail attachment.
  - In the **Format** list, specify the file format to which the results will be saved. The available file formats depend on the type of the scheduled report object.

- **Printer.** Select this option to send the task results to a printer.
  - In the **Printer** list, select the desired printer.
  
  The **Printer** list contains the printers configured on the computer where the Security Services Manager is running.

- **File.** Select this option to save the results to a file on the computer where the Security Services Manager is running.

  Click ![button](image) to set the path and file name to which you want to save the results. If you scheduled the task to run more than once, the file will be overwritten each time the task is run.
12. Click **Finish**.

A message appears informing you that the item has been successfully scheduled. The message displays also information about the date and time of the next occurrence of the item.

**NOTE**

To ensure that the scheduled task is successfully performed, you need to close the Configuration Console if the Report Schedule Manager and the Configuration Console are running on the same machine. If you do not close the Configuration Console, the Report Schedule Manager will cause the disruption of your current Configuration Console activities and the failure of the scheduled task.

---

**Schedule a Report**

**NOTE**

To schedule a report in the Report Explorer tree, you need to have the report user and password configured in the Service Console. For more information refer to the *Administration Guide*, section “Step 15: Register the Information Services Manager”.

**To schedule a report in the Report Explorer tree:**

1. Open the Configuration Console.

2. Right-click the desired report in the Report Explorer tree, and select **Schedule**.
To display the Report Explorer tree, you need to select the Report Explorer option. To do this, select **Report Explorer** on the **View** menu. The Report Explorer tree will appear on the left side of the Configuration Console window. The Report Explorer option is selected by default when you open Configuration Console.

The **Description and Frequency** wizard page appears.

3. In the **Task Description** box, type the description of the task that will be performed.

   For this example, type **Workcell Production Scheduled Task**.

4. Under **Frequency**, select the desired option to specify the task frequency.

   For this example, select **One Time**.
5. Click Next.

The Single Execution wizard page appears.

6. In the Date and Time boxes, specify the exact date and time of performing the task.

7. Click Next.

The Delivery Method wizard page appears.

8. Select one or more of the following distribution methods:

   - E-mail. Select this option to e-mail the task results.
• In the **To** box, type the e-mail address to which the results will be sent as an e-mail attachment.

• In the **Format** list, specify the file format to which the results will be saved. The available file formats depend on the type of the scheduled report object.

• **Printer**. Select this option to send the task results to a printer.

  • In the **Printer** list, select the desired printer.

  The **Printer** list contains the printers configured on the computer where the Security Services Manager is running.

• **File**. Select this option to save the results to a file on the computer where the Security Services Manager is running.

  Click ![To set the path and file name to which you want to save the results.](image)

  If you scheduled the task to run more than once, the file will be overwritten each time the task is run.

9. Click **Finish**.
A message appears informing you that the item has been successfully scheduled. The messages displays also information about the date and time of the next occurrence of the item.

**NOTE**

To ensure that the scheduled task is successfully performed, you need to close the Configuration Console if the Report Schedule Manager and the Configuration Console are running on the same machine. If you do not close the Configuration Console, the Report Schedule Manager will cause the disruption of your current Configuration Console activities and the failure of the scheduled task.

### View the History of the Scheduled Task

Each time the Information Services Manager attempts to perform a scheduled task, a history record documenting the success or failure of the attempt is written to the database. If your task results are not distributed to a specific destination, you can view the schedule history to troubleshoot the problem.

**To view the history of the scheduled task:**

1. Open the Configuration Console.
2. On the **Configure** menu, click **Scheduled Report Objects**.
   
   The **Scheduled Report Objects** dialog box appears.
3. Select the desired task and click **View History**.

   The **Document Schedule History** dialog box appears. It contains a read-only table that displays the history of the scheduled task. Each record in the table represents an instance when FactoryTalk Metrics attempted to perform the task. The table displays the following attributes for each attempt to execute the scheduled task:

   - **Report Title. For scheduled reports only.** The tree label that was applied to the RSBizWare report when it was saved in the Report Explorer tree.
• **Filter.** *For scheduled report objects only.* The name of the filter that was applied to the RSBizWare report object when it was scheduled.

• **Schedule Description.** The name that the user gave to the task when it was scheduled.

• **Log Message.** A message from FactoryTalk Metrics indicating the status of the task (e.g., *Scheduled Item Created, Scheduled Item Dispatched, Scheduled Item Failed*).

• **Run Results.** An additional description of the task results. For example, if your task failed, the run results may contain the reason of the task failure.

• **Log Date.** The date and time when the application attempted to perform the scheduled task.

---

### Analyzing Non-RSBizWare Data

The reporting features of the Configuration Console can be applied to tables or views that exist in non-RSBizWare databases. This is useful if you have data from other software packages or legacy systems that you want to analyze in the Configuration Console.

To analyze non-RSBizWare data in the Configuration Console, you need to create an external data source describing the external database to the Information Services Manager, and a report data source describing the table or view from the external database to the Configuration Console.

### Create an External Data Source

An external data source is the ODBC connection to the SQL Server or Oracle database. The external data source provides a link between the non-RSBizWare database and the Information Services Manager. External data sources are configured in the Service Console. For information on how to create a new external data source, refer to the *Administration Guide*, section "Administering RSBizWare servers".
Create a Report Data Source

A report data source is a connection to a table or view within an external data source. A report data source describes a table or view to the Configuration Console. After your report data source has been created, you can design reports to analyze the data. Refer to "Analyzing FactoryTalk Historian Classic Data (page 41)" for instructions on creating reports.

Before you walk through the tutorial, it is assumed that you have been granted the FactoryTalk Metrics Author license and the Create New Report Data Sources privilege by your RSBizWare administrator.

Step 1: Start the Report Data Source Wizard

To create a report data source:

1. On the Configure menu in the Configuration Console, click Reporting > Report Data Sources, Objects, and Filters.
   The Configure Report Data Sources, Report Objects, and Filters dialog box appears.
2. Under Report Data Sources, click Add.
   The Report Data Source Configuration wizard appears.
3. Click Next.
   The Report Data Source Name page appears.
4. In the Report Data Source Name box, type the name of the report data source.
5. (Optional) To define specific permissions for the report data source, click Permissions. If you do not define them, default permissions are automatically associated with the report data source.
6. Click Next.

NOTE For more information about the default permissions, refer to the Administration Guide, section "Administering RSBizWare servers".
The Choose a Database Table or View page appears.

7. Select the desired database.

   The table at the bottom of the dialog box is filled with the tables and views that exist in the database.

8. Under Name, select the table or view to which you want to create a connection.

9. Click Next.

   The Column Selection page appears.

10. Select the column names that you want to add to the report data source:

   • Under Columns in Table or View, click a column name, and then click >.

     The column is moved under Columns in Report Data Source.

   • To move several columns, press and hold Ctrl, click the columns, and then click >.

   • To move all the columns, click >>.

11. (Optional). Under Columns in Report Data Source, rename the columns:

    1. Click the desired column, and then click Rename.

       The name becomes highlighted for editing.

    2. Change the name, and then press Enter.

12. (Optional). Click Derived Field, and then click Add Derived Field.

   The Add Derived Field dialog box appears.

   A derived field is a new field that is a combination or calculation of existing fields. For example, if your table has the A, B, and C fields, you can create a D derived field containing the value calculated from the expression ((A-B)/C * 100).
1. Under **Field Name**, type a name for the new field.

2. Under **Data Type**, select the data type for the field.

3. Under **SQL Expression...**, do either of the following:
   - Type the expression that will be evaluated to produce the derived field.
   - Choose one of available expressions:
     - Under **Columns**, click a column name.
     - Click **Add Column to Expression**.
     - The expression from the column appears under **SQL Expression**....
     - If you do not select any expression in the **Column** list, and then click **Add Column to Expression**, the first expression in the list is added to the **SQL Expression** box.

13. Click **Validate** to check for errors.
    - If there are no errors, the **Validate** button becomes inactive.

14. Click **Add**.
    - The **Column Selection** page appears.
    - The derived field is displayed under **Columns in Report Data Source**.

15. Click **Next**.
    - The **Time Selection Toolbar** page appears.


17. Click **Next**.
    - The **Time-series Format** page appears.

18. Under **Supported Formats**, select one of the following options that best describes your database table or view:
### Select this option: | If:
---|---
Table is not in a time-series format. | Your table does not contain any time-series data. This setting will disable the time-series analysis and FactoryTalk Transaction Manager time-series data collection for the report data source.
Narrow Format. All Reporting Tags in a single column. | The reporting tag values are stored in a single column of the table.
Wide Format. Each Reporting Tag in separate column. | Your table has a separate column for each reporting tag.
Compression. | Your table contains compressed time-series data that has been collected using the FactoryTalk Transaction Manager Compression engine.

19. Click **Next**.

**NOTE** If you have selected the *Table is not in a time-series format* option, the wizard skips to the last step of the procedure.

The **Match Time-series Columns** page appears.

20. Specify the role of each database field in the time-series analysis:

<table>
<thead>
<tr>
<th>If you have selected this option:</th>
<th>Specify:</th>
</tr>
</thead>
</table>
| Narrow Format | • The field that contains the reporting tag ID.  
• The field that contains the timestamp.  
• The field that contains the value. |
| Wide Format | • One or more fields that contain the reporting tag values.  
• The field that contains the timestamp. |

1. Under **Time-series Use**, click a table cell.

2. From the list, select a role for the cell.

21. Click **Next**.

The **Data Point Configuration Table** page appears.

22. Do either of the following:
• Under **Select the Data Point configuration table**, select a table that holds information about the data points.

• Under **Or create a new table**, click **Create Configuration Table** to have a new table created for you.

The table fields are displayed under **Match the configuration**...

23. If you have selected an existing table, for each database field under **Column** assign a value from the **Time-series Use** column.

24. Click **Next**.

The **Completing the Report Data Source Configuration** page appears.

25. Review the summary of the report data source configuration, and then click **Finish**.

**NOTE**

If the underlying database table or view changes after you have created your report data source, you need to recreate the report data source.
Step 2: Give the Report Data Source a Name

The Report Data Source Name page of the wizard appears.

To name the report data source:

1. On the Report Data Source Name page, enter the name that you will use to refer to your report data source in the application. The name must be unique among all report data sources.

2. (Optional) To define other users' permissions related to your report data source, click Permissions. For this example, accept the default permissions that are automatically associated with new report data sources.

3. Click Next to continue.

NOTE For more information about the default permissions, refer to the Administration Guide, section “Administering RSBizWare Servers”. 
Step 3: Select a Database Table or View

The **Choose a Database Table or View** page (shown below) allows you to specify the database table or view to which the report data source is providing a connection.

1. Select the name of the external data source that contains the table or view. In the example above, the Coffee Datalog Data external data source was selected.

2. When you select an external data source, the list at the bottom of the dialog box fills with the tables and views that exist in the database. Select the table or view to which you want to create a connection.

3. Click **Next** to continue.

Step 4: Choose the Columns That Will Be Included

In this step, you will be selecting from the **Column Selection** page the table/view columns that you want to include in the report data source. Only the columns that you include in the report data source will be available for users to include in report objects that reference this report data source.
1. Highlight the column names that you want to make available to the user and click the Add (>) button to move the column names to the Columns in Report Data Source list.

2. Columns that have been added to the Columns in Report Data Source list can be renamed so the names are more meaningful to users. To rename a column, select the column name in the list and click the Rename button. The name is highlighted to indicate that it is ready to be changed. Type the new name for the column and press the Enter key on your keyboard to accept the changes.

3. Now, let's add a derived field to the report data source. A derived field is a calculated value that is obtained from an expression that you provide. For example, if your table has fields A, B, and C, you could create a derived field called D that contains the value calculated from the expression \(((A-B)/C * 100)\). To add a derived field to your report data source, click the Derived Field button and select Add Derived Field from the shortcut menu to display the dialog box shown below.
4. Enter a name for your new field and type the expression or SQL statement that will be evaluated to produce the derived field.

5. Click the Validate button to check for errors.

6. Click Add to return to the Report Data Source wizard. Your derived field will be displayed in the Columns in Report Data Source list.

7. Click Next to continue.

**Step 5: Enable the Time Selection Toolbar**

This step of the wizard allows you to pick the field from the Time Selection Toolbar page that will be used to restrict the data in the report object by date and time.
Chapter 6  Advanced Reporting Topics

1. The drop-down list contains all timestamp fields that you selected to include in the report data source. To enable the Time Selection toolbar for your report data source, select the timestamp field on which the Time Selection query will be run.

2. Click Next to continue.

**Step 6: Specify the Format of the Table or View**

The **Time-series Format** page allows you to specify whether the table is going to be used for time-series analysis (as shown below). If the table is going to be used for time-series analysis, you must specify what format the table is in.
1. Select the option that best describes your database table or view.

   - Select the **Table is not in a time-series format** option if the table does not contain time-series data. This will disable time-series analysis and FactoryTalk Transaction Manager time-series data collection for the report data source.
   - Select the **Narrow Format** option if the reporting tag values are stored in a single column of the table.
   - Select the **Wide Format** option if the table has a separate column for each reporting tag.
   - Select the **Compression** option if your table contains compressed time-series data that has been collected using the FactoryTalk Transaction Manager Compression engine.

For this example we have selected the Narrow Format.

2. Click **Next** to continue.
If you selected the “not a time-series” option, the wizard will skip steps 7 and 8. The Review Results page will display a summary of the new report data source that will be created. Review your selections and click Finish to create the report data source.

Step 7: Specify the Role That Each Field Plays In Time-Series Analysis

This step displays the Match Time-series Columns page. In this step, you will need to specify the role that each database field plays in time-series analysis. If you selected the “narrow” option in the previous step, you will be required to specify the field that contains the reporting tag ID, the field that contains the timestamp, and the field that contains the value. If you selected the “wide” option in the previous step, you will be required to specify one or more fields that contain the reporting tag values and the field that contains the timestamp.

1. To specify a role for a field, click the Time-series Use cell and select a role from the list that will be displayed.

2. Click Next to continue.
Step 8: Create a Data Point Configuration Table

The final step of the wizard contains the Data Point Configuration Table page shown below. Here you set up the data point configuration table, which is a database table that contains descriptive information about the reporting tags, including a reporting tag ID field, a reporting tag description field, and an engineering unit field. The data point configuration table will be joined to the report data source table by the reporting tag ID field. Each time-series report data source must use a different configuration table.

1. Select a table from the drop-down list or click the Create Configuration Table button to create a new table. The table fields will be listed in the grid at the bottom of the dialog box.

2. For each field in the configuration table, click the Timeseries Use cell and select a role from the list that will be displayed. This step is not necessary if you used the Create Configuration Table button to create a new table.

3. Click Next to display the Review Results page. This dialog box displays a summary of the new report data source that will
be created. Review your selections and click **Finish** to create the report data source.

**NOTE** If the underlying database table or view changes after you create your report data source, you must recreate the report data source to take advantage of the changes.
Creating RSBizWare Custom Analysis Tools

An RSBizWare custom analysis tool is a user-defined plug-in to the Configuration Console that allows you to develop custom computations that operate on time-series data. The result of the custom analysis tool computations then can be displayed on a time-series chart.

Why Use Custom Analysis Tools?

The Configuration Console ships with several standard statistical analysis tools. Why would you want to develop and use RSBizWare custom analysis tools? The biggest reason is to allow you to visualize different types of statistics or calculations that are particular to your process without having to export the data from the Configuration Console into another package. While the custom analysis tool architecture is not as powerful as a fully featured analysis package such as SAS or Excel, many analysis functions can be quite easily implemented as custom analysis tools.

Intended Audience

This chapter is intended for individuals who want to make use of custom analysis tools developed by others, as well as for individuals who want to develop custom analysis tools to chart specific statistics or calculations.

This chapter leads you through a quick tour of a custom analysis tool that ships with the Configuration Console and then discusses how to build custom analysis tools with Microsoft Visual Basic and Microsoft Visual C++.

- If you plan to use custom analysis tools that others develop, you only need to read the Quick Tour section of this chapter.
Chapter 7  Creating RSBizWare Custom Analysis Tools

- If you plan to develop custom analysis tools, we recommend that you read the next three sections of this chapter followed by the section that describes how to develop a custom analysis tool using your chosen development tool.

**NOTE**

If you will be using a development tool other than Visual Basic or Visual C++, make sure you read the RSBizWare Calculator COM Interface section.

You can use any development tool that supports authoring COM classes to develop your custom analysis tool. It is assumed that you have a working knowledge of the development tool you will be using. The User Guides for Microsoft Visual Basic and Microsoft Visual C++ provide valuable information on producing COM DLLs.

While the RSBizWare Custom Analysis Tool plug-in architecture uses COM, you do not have to be an expert on COM in order to implement a custom analysis tool. However, some familiarity with COM is helpful in understanding how custom analysis tools work under the hood. The following references provide excellent overviews of COM:


**A Quick Tour of a Sample Custom Analysis Tool**

Before you dive into writing a custom analysis tool, let’s look at how a sample pre-built custom analysis tool is added into the Configuration Console. It is assumed that you are running the client and the server on a single computer and that you already have started the Configuration Console and logged into the Information Services Manager.
Registering a Sample Analysis Tool

Before you can use a custom analysis tool, you must first register it with the Configuration Console by doing the following:

1. Select **Tools > FactoryTalk Historian Classic > Analysis Tools** from the main menu. The Configure Custom Analysis Tools dialog box, shown below, is displayed. This dialog box enables you to manage the custom analysis tools that are registered on your machine. Initially, the list of configured analysis tools will be empty.

![Configure Analysis Tools dialog box](image)

2. Click **Add** to register a new custom analysis tool. A file browser will come up that will allow you to select a DLL or OCX file that contains one or more analysis tools to register. RSBizWare ships with two sample custom analysis tools. Both analysis tools do the same calculation, but one was developed with Visual Basic, and one was developed with Visual C++. You will register the one built with Visual Basic.

3. Browse to the \Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\VB\VbFlat directory, select the **VbFlat.dll** file, and click **Open**. This will verify that the DLL you have chosen contains a valid custom analysis tool.
4. If the DLL has not yet been registered with the Windows operating system, the Configuration Console will offer to do this for you. Click Yes.

5. You will then return to the Configure Custom Analysis Tool screen where you will see all custom analysis tools that are present in the DLL you chose.

You will see how the analysis tools get their names in the development sections. In addition to the name of the analysis tool, you will also see a series of numbers and letters in braces.
following the analysis tool name. That is a global unique identifier (GUID), which is what Microsoft Windows uses to identify software components uniquely. You can ignore the GUID.

**NOTE**
If you select a DLL, EXE, or OCX file that does not contain a valid custom analysis tool, you will see the following message: “The selected file is not a valid Analysis Tool (it does not contain a type library).” To fix this with the sample custom analysis tool, select the correct DLL that contains the custom analysis tool and try again.

6. **Click OK** to exit the Configure Custom Analysis Tool screen. The new custom analysis tool is now registered.

You only need to register a custom analysis tool one time in the Configuration Console. After a custom analysis tool is registered, the Configuration Console automatically loads the custom analysis tool when it is needed.

### Using the Sample Analysis Tool for Time-series Analysis

Once you have registered a custom analysis tool, you can use it on time-series charts just as you would use the built-in analysis tools that are delivered with the software. See chapter "Analyzing FactoryTalk Historian Classic Data (page 41)" for information on how to apply an analysis tool to a time-series chart.

### What You Need to Know Before You Start

RSBizWare installs two sample custom analysis tools. Both custom analysis tools compute the exact same thing—a weighted average of the selected data set. One sample analysis tool was written in Visual Basic and one was written in Visual C++. While the output of each sample analysis tool is identical, the work involved to develop each analysis tool is quite different. You will take a quick tour of the VbFlat sample analysis tool.

The VbFlat sample custom analysis tool was developed in Visual Basic. To look at the VbFlat project, start Visual Basic and open the VbFlat.vbp project in the directory from which you registered the VbFlat.DLL in "Registering a Sample Analysis Tool (page 127)".
You will see that the Visual Basic project contains only one file—a Visual Basic class named VbFlatCalculator.

The section on developing a custom analysis tool with Visual Basic will detail the steps necessary to develop a custom analysis tool, but you will notice that the name of the class in Visual Basic is the name that is used in the Configuration Console to display the custom analysis tool. If you open the class file in Visual Basic, you can browse the `RSBizWareCalculator_Calculate` function to get an idea of the computations this analysis tool performs.

You can start Visual C++ and open the analogous Visual C++ project located in the `\Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\C++\Flat` subdirectory.

**Analysis Tool Architecture**

The RSBizWare custom analysis tool architecture is built on COM, the Component Object Model. COM was chosen as the architecture for custom analysis tools because it allows custom analysis tools to be written using any development tool that supports the creation of COM classes. This gives great flexibility to developers of custom analysis tools.

Custom analysis tools are COM classes that typically are stored in a DLL. You can store multiple custom analysis tools in a DLL, and
you can register multiple custom analysis tool DLLs with a Configuration Console. Each custom analysis tool will show up under the Analysis Tool list associated with each reporting tag selected for use within a reporting object.

To create a custom analysis tool, you need to implement a single COM interface published by Rockwell Automation: RSBizWare::IRSBizWareCalculator. What this really means is that you have to write a single function in the development tool of your choice that can take a set of data as input and return a calculated set of data as output. The RSBizWare::IRSBizWareCalculator interface expects you to implement one method called Calculate().
Chapter 7  Creating RSBizWare Custom Analysis Tools

What a Time-series Data Set Looks Like

Usually, RSBizWare custom analysis tools are used to analyze time-series data sets. Before looking in-depth at how to build a custom analysis tool, it is essential to understand what a time-series data set looks like, as you will need to interpret the parameters that will be passed into your `Calculate()` function.

Generally, time-series data is made up of three parameters: a data point (or tag) name, a timestamp and a value. However, the Information Services Manager has the built-in ability to sample large data sets on the server side when querying a large number of records.

For example, if you are collecting a data point called Pressure every 10 seconds in a year’s time, you will have over 3 million records for that data point stored in the FactoryTalk Historian Classic time-series database. Obviously, it is not feasible or useful to send all 3 million records to an RS BizWare client for display. Therefore, the Information Services Manager uses a sampling algorithm to return only the number of records necessary to display the data set accurately on the RS BizWare client. The necessary number of records to send to an RS BizWare client is actually part of the client’s request and depends on the size and resolution of the display device that the client is using. It is based on the number of horizontal screen pixels the time-series chart will occupy.

When using a sampling algorithm, the RS BizWare server will divide the requested time range into a number of equally spaced time buckets. To accurately display the data in the RS BizWare client, the server then finds the minimum and maximum value of the requested data point for each time bucket and also finds the number of data point records that are part of each bucket. The number of data point records in a sample may be important when developing weighted analysis tools when the data point is not uniformly sampled. All of this information is returned to the Configuration Console, and this same information is passed into the custom analysis tool.
Calculate() function you develop. The following table shows an example of what an RSBizWare time-series data set looks like.

<table>
<thead>
<tr>
<th>Data point</th>
<th>Timestamp</th>
<th>Min value</th>
<th>Max value</th>
<th>Sample count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure</td>
<td>2000-06-20 07:00:00</td>
<td>7.5</td>
<td>8.3</td>
<td>360</td>
</tr>
<tr>
<td>Pressure</td>
<td>2000-06-20 08:00:00</td>
<td>8.3</td>
<td>9.5</td>
<td>360</td>
</tr>
<tr>
<td>Pressure</td>
<td>2000-06-20 09:02:00</td>
<td>8.5</td>
<td>9.5</td>
<td>360</td>
</tr>
<tr>
<td>Pressure</td>
<td>2000-06-20 10:03:00</td>
<td>9.5</td>
<td>13.4</td>
<td>360</td>
</tr>
<tr>
<td>Pressure</td>
<td>2000-06-20 11:04:00</td>
<td>13.4</td>
<td>17.5</td>
<td>360</td>
</tr>
<tr>
<td>Pressure</td>
<td>2000-06-20 12:05:00</td>
<td>17.5</td>
<td>16.1</td>
<td>360</td>
</tr>
</tbody>
</table>

When the Information Services Manager determines that there are not enough records in the requested time-series data set to necessitate sampling, the server will forego the sampling algorithm and return the raw data point records to the client. In this case, the minimum and maximum values will be identical and the count of data points per sample record will be 1.

**Interpreting the Parameters Passed into the Calculate() Function**

When you write a custom analysis tool, the time-series data set parameters described above are passed into the `Calculate()` function you implement:

- **X-Axis input array**—This array contains double precision floating point values, which are the X-axis values of the data set. For time-series templates, the X-axis is always a set of date values. Date values are represented in the Configuration Console in COM DATE format, which means they are double precision floating point values. You will typically not do computations with X-axis values for time-series templates.

- **Y-Axis Minimum input array**—This array contains double precision floating point values which are the minimum values of each X-axis sample of the data set.

- **Y-Axis Maximum input array**—This array contains double precision floating point values which are the maximum values of each X-axis sample of the data set.
Chapter 7  Creating RSBizWare Custom Analysis Tools

• Count input array—This array contains double precision floating point values, which are the counts of the number of samples for each X-axis sample of the data set. When the Information Services Manager determines that sampling is not required, the counts will be 1.

When implementing the `Calculate()` function, your job is to fill up two output parameters which will contain the X and Y values of your custom analysis tool algorithm.

• X-Axis output array—This array is generated by the custom analysis tool and contains double precision floating point values. It generally has the same, or a subset of, the X-axis values that were passed in the X-axis input array data set.

• Y-Axis output array—This array is generated by the custom analysis tool and contains double precision floating point values. It contains the Y value produced by the algorithm in the custom analysis tool.

Limitations

The RSBizWare custom analysis tool toolkit currently limits you to doing calculations with a single input variable. Also, you cannot store permanently any additional parameters that your custom analysis tool may require.

The RSBizWare Calculator COM Interface

RSBizWare custom analysis tools are developed using COM, the Component Object Model. As mentioned at the beginning of this chapter, COM was used primarily because it allows custom analysis tools to be developed with any development tool and language that supports creating COM classes.

The RSBizWare custom analysis tool architecture defines an instance of a COM Category, which is a way for RSBizWare easily to find all custom analysis tools that have been registered on a machine. When you use the Configuration Console to register a custom analysis tool (as you did with the sample VbFlat analysis
tool), the Configuration Console automatically generated a COM Category entry for the analysis tool for you.

**Looking at the Type Library**

As mentioned in "Analysis Tool Architecture (page 130)", developing an RSBizWare custom analysis tool requires you to implement a specific COM interface called `RSBizWare::IRSBizWareCalculator`.

To implement an RSBizWare custom analysis tool, you will need a COM Type Library so that your development tool knows the syntax of the function you need to write. The type library for the custom analysis tools is installed and registered with the Configuration Console. The type library file is called RSBizWareCalculator.tlb and is located by default in the \Program Files\Rockwell Software\RSBizWare directory.

Normally, you do not need to know the exact location of this file. Rather, your development tool will allow you to browse the list of registered COM classes. The RSBizWare custom analysis tool interface shows up in developer tools as RSBizWareCalculator 1.0 Type Library. An example of this in Visual Basic is shown below.
The `RSBizWare::IRSBizWareCalculator` interface requires you to implement a function called `Calculate()`. COM uses the Interface Definition Language (IDL) to describe the syntax of functions in a language independent manner. The IDL for the `Calculate()` function follows:

```idl
[id(1), helpstring("method Calculate")]
HRESULT Calculate([in] VARIANT xInArray,
                   [in] VARIANT yMinInArray,
                   [in] VARIANT yMaxInArray,
                   [in] VARIANT CountInArray,
                   [in, out] VARIANT* xOutArray,
                   [in, out] VARIANT* yOutArray);
```

The parameters used in the `Calculate()` function are those described in "Interpreting the Parameters Passed into the Calculate() Function". You will notice that the data types of all parameters are `VARIANTs`. A `VARIANT` data type can hold many types of values, including strings, integers, and arrays. In this case, each of the parameters are arrays of numbers, but the `VARIANT` data type was still used because it allows the exchange of data between Visual Basic and C++, and it allows for dynamic data types when the output of an analysis tool is a single value.

Note that the last two parameters are marked as [in, out]. They actually are output only parameters but Visual Basic needs the [in, out] designator in order to work properly.

**Developing Analysis Tools with Visual Basic**

Visual Basic is the easiest tool to use when developing a custom analysis tool. Visual Basic does a good job of handling the `VARIANT` data type used by the custom analysis tool interface.
Creating RSBizWare Custom Analysis Tools

Chapter 7

Creating a New Project

To create a new custom analysis tool in Visual Basic, do the following:

1. Start the Visual Basic application.

2. If the New Project dialog box is not automatically displayed, select **File > New Project** from the Visual Basic menu.

3. Select **ActiveX DLL** from the list on the New Project dialog box and click **OK**. You will be placed in the Visual Basic code editor with a default project name and a default class name created for you.

4. For this example, you are going to write an analysis tool that plots the negative values of the data set, so change the name of the default class from **Class1** to **NegativeCalculator**.

Configuring Important Project Settings

You will now configure the project settings that are needed when you compile the project. The name of an RSBizWare custom analysis tool is determined by the Visual Basic project and class names using the format **VisualBasicProjectName.ClassName**. Therefore, it is important to give your custom analysis tool a meaningful project and class name that will identify it uniquely in the Configuration Console as follows:

1. Change the project name from the Visual Basic default name, by selecting **Project > Project 1 Properties** from the menu. The Project1 - Project Properties dialog box is displayed.

2. Change the project name on the General tab to **MyDemo**.

3. Leave the rest of the settings on this page to their defaults.

4. Click **OK** to save the project settings.
Chapter 7  Creating RSBizWare Custom Analysis Tools

Referencing the RSBizWare Calculator Component

Next, you must specify to Visual Basic that you are going to be implementing an RSBizWare custom analysis tool as follows:

1. Add a reference to a COM or ActiveX object in Visual Basic by selecting Project > References.
2. In the References dialog box, scroll down the list of all registered COM interfaces until you see the RSBizWareCalculator 1.0 Type Library. Select it and click OK.
3. Specify to Visual Basic that a particular class is implementing the RSBizWare::IRSBizWareCalculator interface by adding the following implements statement in the code window and pressing the Enter key:
   1. Implements RSBizWareCalculator
4. In the top left list in the code window, select RSBizWareCalculator. Visual Basic will generate a default implementation of the only method in the interface: Calculate(). You now have an empty shell for writing the Calculate() function.

Writing the Calculate() Function

Now that the RSBizWare custom analysis tool interface is registered with the Visual Basic project, you are ready to implement the Calculate() function. Writing the Calculate() function involves a few basic steps:

1. Accessing the passed in data set from the Configuration Console.
2. Computing the desired algorithm.
3. Returning an output data set to the Configuration Console.

If you look at the parameters passed into the Calculate() function, you will see that they match the parameters listed in the IDL code shown in "Looking at the Type Library (page 135)". (Note that
carriage returns and line continuation characters were added to this code for readability.)

Private Sub RSBizWareCalculator_Calculate(  
    ByVal xInArray As Variant,  
    ByVal yMinInArray As Variant,  
    ByVal yMaxInArray As Variant,  
    ByVal CountInArray As Variant,  
    xOutArray As Variant,  
    yOutArray As Variant)
End Sub

The only real difference from the IDL code is that Visual Basic converted the generic [in] and [in, out] IDL keywords into the ByVal and ByRef syntax that Visual Basic uses. (The ByRef keyword is the default if neither ByVal nor ByRef is specified.)

The purpose of the analysis tool is to compute the negative value of each Y-axis value that was passed into the function. To do this the program must loop through each value passed in and create a corresponding output value that is the same numeric value except with the sign changed (for example, you'll be turning the value 5.3 into -5.3).

To complete the Calculate() function, do the following by adding the specified code to the function:

1. Determine the size of the output array. The Configuration Console does not assume that the output array will be the same size as the input array. In this case, the program will return X and Y arrays of the same size, but the program must still allocate the arrays in the Calculate() function as follows:

```vbnet
' In this calculator, we will return the same size of array  
' as was passed in
ReDim xOutArray(0 To UBound(yMinInArray)) As Double  
ReDim yOutArray(0 To UBound(yMinInArray)) As Double

The Visual Basic Ubound() function returns the upper bound of the passed in array.
```
2. Change the Y values to negative values. This task would be simple if you were dealing with single data points; however, you have to take sampling into consideration because the passed in data set may be sampled. If it is, the program must contain an algorithm to determine the value to make negative. In this program, you negate the average of the minimum and maximum value passed in for each sample:

```vbnet
' Set the output Y value equal to the negative y input value for every X (timestamp) value that was passed in
' In case we are sampling, we will use the average of the min and max value that was passed in
Dim i As Integer
For i = 0 To UBound(yMinInArray)
    xOutArray(i) = xInArray(i)
    yOutArray(i) = -1# * (yMinInArray(i) + yMaxInArray(i)) / 2#
Next i
```

The -1# and 2# values are Visual Basic’s default way of displaying floating point numbers. The values were typed in as -1.0 and 2.0 respectively.

The full `Calculate()` function along with the entire sample project is installed with RSBizWare in the \Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\VB\NegativeCalc directory. You should refer to this sample project to see the exact form of the code in the `Calculate()` function.

### Saving and Compiling the Project

Before you can try out the new custom analysis tool, you have to save the Visual Basic project and compile the DLL as follows:

1. Select **File > Save Project** to save the project. If you haven’t saved the project yet, you will need to select a directory. Since you already set the project properties when you created the project, the name of the project already should be set to **MyDemo**.
2. To compile your project, select **File > Make MyDemo.dll**. You will be prompted for a directory to save the DLL to. As far as the Configuration Console is concerned, it does not matter where the DLL resides on the machine, so pick the directory of your choice.

Once you have saved and compiled your project for the first time, you should change the Version Compatibility of the project as follows:


2. Select the **Component** tab and change the Version Compatibility selection to **Binary Compatibility**.

3. Save and recompile your project.

If you use No Compatibility or Project Compatibility and register the custom analysis tool in the Configuration Console and then recompile the custom analysis tool in Visual Basic, you will have to re-register the analysis tool in the Configuration Console.

Register your MyDemo custom analysis tool DLL as you did with the sample VbFlat analysis tool (as described in "Registering a Sample Analysis Tool (page 127)"). Once the analysis tool is registered, you can use the MyDemo.NegativeCalculator analysis tool with the FactoryTalk Historian Classic Demo - Pressure data point.

**NOTE**
If your database does not have this data point, you have not installed the FactoryTalk Historian Classic sample data. To do this, run the DB Load Wizard from the Start menu by selecting **Programs > Rockwell Software > FactoryTalk Tools > Database Wizard**. Follow the directions in the help to install the FactoryTalk Historian Classic sample data into the database you are using.
Your report object should look like this:

![Time-Series Analysis](image)

If the name of your custom analysis tool in the Configuration Console is not what you expected (MyDemo.NegativeCalculator), then you may not have renamed the default project or class name in the Visual Basic project. If you did not rename these, then your analysis tool may be named Project1.Class1. You can go back to Visual Basic, change the names, and recompile your project. Then when you unregister and register the custom analysis tool in the Configuration Console, the name should show up correctly.

**Debugging Custom Analysis Tools in Visual Basic**

You may find that a custom analysis tool that you develop does not calculate as expected on the first try. When custom analysis tools are producing incorrect values, the easiest way to find the problem is to debug them with the Visual Basic debugger.

To set the debugger up, do the following:

1. Access the Visual Basic project settings for your custom analysis tool under Visual Basic’s Project menu item and select the **Debugging** tab.

2. Select the **Start program** option, select the Configuration Console executable (`\Program Files\Rockwell Software\RSBizWare\RSBizWare Production Client.exe`) as the program to run when the debugger starts, and click OK.
Creating RSBizWare Custom Analysis Tools

Chapter 7

After the debugging settings are complete, you can set one or more breakpoints in your Visual Basic `Calculate()` function. When you then run the project, the Configuration Console will start up. Create a time-series chart using the analysis tool you are debugging (you may have to first register the analysis tool if you haven’t yet). When the chart calls the analysis tool, your breakpoints should be called in Visual Basic. You can then step through your Visual Basic code, using the full features of the Visual Basic debugger.

The complete source files for this project are installed with RSBizWare in the \Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\VB\NegativeCalc directory.

Developing Analysis Tools with Visual C++

Developing custom analysis tools with Visual C++ provides several benefits over using Visual Basic:

- Fewer dependencies. Distributing a Visual Basic custom analysis tool requires the distribution of the Visual Basic runtime DLL MSVBVM60.DLL. The method you will use to
develop the C++ analysis tool should require no other distribution DLLs.

- **Decreased Memory Usage.** The Visual Basic MSVBVM60.DLL adds a considerable memory footprint to a custom analysis tool. The Visual C++ custom analysis tools are very memory efficient and, with no dependencies, they require loading no other DLLs.

- **Increased Performance.** If you are doing extensive computations in your custom analysis tools, you may notice a significant performance increase by using Visual C++.

These benefits come with a trade-off—developing custom analysis tools in Visual C++ is more complicated than using Visual Basic. Visual Basic handles VARIANT data types more intuitively than Visual C++ does. Plus, Visual Basic hides the underlying COM details much better than Visual C++.

The final choice in deciding which tool to use comes down to deciding if you can live with Visual Basic’s increased memory and performance overhead. For most analysis tools, the performance difference is not that noticeable.

**Creating a New Project**

To create a new custom analysis tool in Visual C++, do the following:

1. Start the Visual C++ application.

2. Select **File > New**.

3. Under the **Projects** tab, select **ATL/COM AppWizard**, name the project **NegativeC** (since it will be the C++ implementation of the analysis tool you did in the Visual Basic tutorial), and click **OK**.

4. You now have the option of selecting the executable form of this project. You will be creating an in-process DLL for the custom analysis tools, so select the **Dynamic Link Library**
Creating RSBizWare Custom Analysis Tools

Chapter 7

(DLL) option. Leave the check boxes at the bottom of the screen cleared as shown in the example.

5. Click Finish and then click OK on the next screen. Visual C++ will create the shell of the project for you.

You now have an empty COM DLL from which you can build the analysis tool.

Referencing the RSBizWare Calculator Component

The way to implement a custom analysis tool in Visual C++ is to create a new COM class and then implement the RSBizWare::IRSBizWareCalculator interface in the new COM Class.

To create a new COM class and implement the interface, do the following:

1. Select Insert > New ATL Object. The ATL Object Wizard dialog box is displayed.

2. Select Simple Object from the Objects list and click Next.
3. Specify **NegativeCalc** as the short name of this class. Filling in the Short Name field will fill in default values for the rest of the fields on the screen.

4. Click **OK** to complete the creation of the class. Visual C++ then will create a new empty COM class.

5. To make the class implement the **RSBizWare::IRSBizWareCalculator** interface, access the **Class View** tab in C++, expand the **NegativeC classes** folder, right-click the **CNegativeCalc** class, and select **Implement Interface** from the shortcut menu.

![Image of Class View with Implement Interface option highlighted]

6. You will see a message from Visual C++ warning that it could not find a type library for the project. Click **OK**, browse the displayed list of available type libraries, select **RSBizWareCalculator 1.0 Type Library (1.0)**, and click **OK**.

7. When you select the RSBizWareCalculator 1.0 Type Library, you will be prompted to select the COM interfaces from that type library that the class will implement. In this case there is only the **IRSBizWareCalculator** interface in the type library. Select it and click **OK**.

1. Visual C++ adds declarations for the interface into the header file of the new CNegativeCalc class. It also adds an empty **Calculate()** function to the class since the class now implements the IRSBizWareCalculator interface.

You are almost ready to write the **Calculate()** function in C++. But first you need to understand how Visual C++ deals with VARIANT data types.
Visual C++ supports the VARIANT data type, but VARIANTs are not handled as elegantly in Visual C++ as they are in Visual Basic. When RSBizWare is installed, a set of C++ source code files that contain utility functions are also installed. In the Variant.cpp file, there are functions that are useful when handling VARIANT data types. These files are installed in the \Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\C++\utility directory.

To use these VARIANT functions in your program, do the following:

1. Copy the Variant.h and Variant.cpp files from the utility directory (\Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\C++\Utility, by default) to your project's source directory.

2. Add the Variant.cpp file to your project's Source Files (by right-clicking the Source Files folder, selecting Add Files to Folder from the shortcut menu, and selecting the file).

3. Include Variant.h before the class definition in the NegativeCalc.h header file (by adding an #include "Variant.h" statement to the NegativeCalc.h header file).

An excerpt of the Variant.h include file is listed below that describes the utility functions implemented in the Variant.cpp file.

```c
// Returns TRUE if a VARIANT has a type of VT_ARRAY|R8
// (array of doubles).
bool IsVariantDoubleArray(VARIANT *varray);

// Returns the number of elements in the array contained in a // VARIANT.
long GetVariantDoubleArraySize(VARIANT *varray);

// Converts a VARIANT 1-dimensional SafeArray of doubles to a // non-variant double array.
bool ExtractVariantDoubleArray(VARIANT *varray, double *vals, int sizeVals, int *numVals);

// Converts a non-variant double array to a VARIANT 1- // dimensional SafeArray of doubles
void CreateVariantDoubleArray(double *vals, int numVals,
```
You will use these utility functions when you write the Calculate() function in the next section.

Writing the Calculate() Function

Writing the Calculate() function (contained in the NegativeCalc.h file) in Visual C++ involves the same basic steps described in the Visual Basic section:

1. Accessing the passed in data set from the Configuration Console.
2. Computing the desired algorithm.
3. Returning an output data set to the Configuration Console.

The parameters passed into the Calculate() function match the parameters listed in the IDL code you previously looked at:

```c
STDMETHOD(Calculate)(VARIANT xInArray,
                     VARIANT yMinInArray,
                     VARIANT yMaxInArray,
                     VARIANT CountInArray,
                     VARIANT * xOutArray,
                     VARIANT * yOutArray)
```

The syntax that Visual C++ uses to implement the function may look strange at first, but it is the standard way to declare methods in COM classes when using the Active Template Library (ATL)—a library that simplifies much of the boilerplate code necessary when writing COM classes.

The purpose of the analysis tool is to compute the negative value of each Y-axis value that was passed into the function. To do this, the program needs to loop through each value passed in and create a corresponding output value that is the same numeric value except with the sign changed (for example, the program must turn the value 5.3 into -5.3).
The first thing the program must do is check that valid output pointers were passed into the `Calculate()` function. The following code is created automatically for the `Calculate()` function by Visual C++:

```c++
if (xOutArray == NULL)
    return E_POINTER;

if (yOutArray == NULL)
    return E_POINTER;
```

To complete the `Calculate()` function, do the following by adding the specified code to the function (contained in the NegativeCalc.h file):

1. Determine the size of the output array. The Configuration Console does not assume that the output array will be the same size as the input array. In this case, the program will return X and Y arrays of the same size, but the program must still allocate the arrays in the `Calculate()` function. The following code determines the size of the input arrays by using the `GetVariantDoubleArraySize()` utility function:

   ```c++
   // Convert input args to double arrays
   long xInSize = GetVariantDoubleArraySize(&xInArray);
   long yMinInSize = GetVariantDoubleArraySize(&yMinInArray);
   long yMaxSize = GetVariantDoubleArraySize(&yMaxInArray);
   long countInSize = GetVariantDoubleArraySize(&CountInArray);
   ```

2. Extract the data from the input arrays. Remember, the data is passed in as a series of VARIANTs which contain arrays of double precision floating point numbers. Another VARIANT utility function (ExtractVariantDoubleArray()) is used to convert the VARIANTs into arrays of C++ native double precision floating point numbers:

   ```c++
   // Create double arrays to hold the values in the VARIANT array input args
   double *xIn = new double[xInSize];
   double *yMinIn = new double[yMinInSize];
   ```
3. Create the output arrays. Since an output value is needed for each input value, the size of the output arrays will be the same size as the input arrays:

```c++
// Create temp double arrays, which can be destroyed after
// they are converted to VARIANT arrays by
// CreateVariantDoubleArray()
double *xOut = new double[xInSize];
double *yOut = new double[xInSize];
```

4. Change the Y values to negative values. This task would be simple if you were dealing with single data points; however, you have to take sampling into consideration because the passed in data set may be sampled. If it is, the program must contain an algorithm to determine the value to make negative. In this program, you negate the average of the minimum and maximum value passed in for each sample:

```c++
// Set first point of horizontal line in output arrays
for (int i = 0; i < xInSize; i++)
{
    xOut[i] = xIn[i];
    yOut[i] = -1.0 * (yMinIn[i] + yMaxIn[i]) / 2.0;
}
```

5. Convert the output variables (xOut and yOut) into VARIANTs so that they can be passed back to the Configuration Console. Another VARIANT utility function (CreateVariantDoubleArray()) is used to do this:

```c++
// Convert the temp double arrays to VARIANT arrays to return
```
6. Having completed the data algorithm, the only thing left to do is to clean up the temporary variables used during the computations. Make sure that you use the array delete operator (delete[]) when deleting the temporary arrays, otherwise your custom analysis tool will leak memory each time it is run.

```cpp
delete [] xOut;
delete [] yOut;
delete [] xIn;
delete [] yMinIn;
delete [] yMaxIn;
delete [] countIn;
```

The full `Calculate()` function along with the entire sample project is installed with RSBizWare in the `Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\C++\NegativeC` directory. You should refer to this sample project to see the exact form of the code in the `Calculate()` function.

**Saving and Compiling the Project**

There is one more piece of functionality you need to add to the custom analysis tool DLL. Earlier, you saw how instances of RSBizWare custom analysis tools belong to something called a COM Category. To make sure the new custom analysis tool registers as part of the category, do the following:

1. Copy the `Register.h` and `Register.cpp` files from the utility directory (`Program Files\Rockwell Software\RSBizWare\RSBizWare Calculators\C++\utility, by default) to your project’s source directory.

2. Add the `Register.cpp` file to your project’s Source Files (by right-clicking the Source Files folder, selecting Add Files to Folder from the shortcut menu, and selecting the file).
3. Include `Register.h` before the class definition in the `NegativeCalc.h` header file (by adding an `#include “Register.h”` statement to the NegativeCalc.h header file).

Before compiling the project, you need to alter the project settings as follows:

1. Select **Project > Settings**.
2. On the dialog, select **Win32 Release MinDependency** from the Settings For list at the top of the dialog box.
3. Select the **C/C++** tab and remove the macro named `_ATL_MIN_CRT` at the end of the Preprocessor definitions box. (Note that this macro was removed from the example project.)

4. Click **OK** to save your changes.
5. You are now ready to compile the project. You have several options when compiling a COM DLL in Visual C++.
   - It is recommended that you compile the project in debug mode while developing the custom analysis tool. This will allow you to step into the `Calculate()` function when it is called from the Configuration Console. You will see how this is done in "Debugging Custom Analysis Tools in Visual C++ (page 153)".
• After the custom analysis tool is debugged, it should be recompiled in non-debug mode for production use and distribution. There are several choices of non-debug compilation in Visual C++. You should select the Win32 Release MinDependency compilation mode. This minimizes the dependencies of the compiled DLL so you don’t have to ship any other DLLs with the custom analysis tool.

To compile the project, select **Build > Rebuild All.**

Register your NegativeC custom analysis tool DLL as you did with the sample VbFlat analysis tool (as described in ). The DLL will be under either a Debug or ReleaseMinDependency directory, depending on the mode in which you compiled the DLL.

After the analysis tool is registered, you can use it on a time-series report object with the FactoryTalk Historian Classic Demo - Pressure data point. Your report object should look like this.
If your custom analysis tool does not work in the Configuration Console the first time, you may need to debug your `Calculate()` function. The easiest way to do this is to use the Visual C++ debugger when running the Configuration Console as follows:

1. Select **Project > Settings** from the menu.
2. On the Project Settings dialog box shown below, select the **Debug** tab. Make sure you have the **Win32 Debug** selected from the Settings For list.
3. On the Executable for debug session box, click the arrow button to browse and select the Configuration Console executable (`\Program Files\Rockwell Software\RSBizWare\RSBizWare Production Client.exe`).
4. Click **OK** to save your changes.

Now, when you debug the project, the Configuration Console will be started. You then can set debug breakpoints in your `Calculate()` function. When you use your custom analysis tool in a time-series chart, your breakpoints will be called in Visual C++. You can then use the full power of the Visual C++ debugger to track down your problem.
Creating RSBizWare Custom Analysis Tools

Chapter 7

Why Use Custom Analysis Tools?

The RSBizWare installation creates a directory structure that contains samples and utility files that are useful when creating custom analysis tools. The directory contents are described below.

- \RSBizWare Calculators: This is the root directory of the Calculator SDK on the DVD.

- \RSBizWare Calculators\VB\NegativeCalc: The complete Visual Basic project files for the NegativeCalc custom analysis tool described in this chapter.

- \RSBizWare Calculators\C++\NegativeC: The complete Visual C++ project files for the NegativeC custom analysis tool described in this chapter.

- \RSBizWare Calculators\C++\utility: This directory contains C++ source files that implement utility functions that are very useful when developing custom analysis tools with Visual C++. One set of files (Variant.cpp, Variant.h) contains functions that operate on VARIANT arrays. The second set of files (Register.cpp, Register.h) contains functions that register a custom analysis tool properly using COM categories.
Object Permissions

An object permission is a privilege that is granted to security groups or individual users that allows access to a specific object within the client application. An example of an object permission for which users and groups can be given privileges is the ability to edit a particular report object. For example, if a user is granted the Edit Report Object permission for the report object called Test Report Object, then they will be able to make and save changes to that report object.

Individual users can have object permissions granted to them, and they can inherit object permissions from the security groups to which they belong. For example, if a group has been granted the Edit Report Object permission for the Test Report Object, users assigned to that group are also able to edit the report object.

Object permissions are granted through the Configuration Console. For more information, refer to the Configuration Console online help.

You may also set the baseline permissions that will be given to a certain group or user for every instance of an object type that is created in the Configuration Console. For example, if you want a user to have permission to edit every report object that is ever created in the client application, you need to set the Edit Report Object default security permission on the Report Object type for the particular use. After you have assigned default permissions to a type of object, the creator of a new object of that type may choose to revoke an individual user’s permissions to his newly created object.

NOTE: Revoking permissions is performed in the Configuration Console. For more information, refer to the Configuration Console online help.
Default object permissions are granted through the Service Console. For information, refer to the *RSBizWare Administration Guide*, "Configuring default object permissions".

**Filter permissions**

There are the following filter permissions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Filter</td>
<td>Allows the selected users or groups to delete the filter. Author Licenses only.</td>
</tr>
<tr>
<td>Edit Filter</td>
<td>Allows the selected users or groups to make changes to the filter. Author Licenses only.</td>
</tr>
<tr>
<td>Edit Filter Security</td>
<td>Allows the selected users or groups to grant security permissions for the filter to other users or groups. Author Licenses only.</td>
</tr>
<tr>
<td>View Filter</td>
<td>Allows the selected users or groups to view the filter.</td>
</tr>
</tbody>
</table>

**Report permissions**

There are the following report permissions:

<table>
<thead>
<tr>
<th>Permissions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Report</td>
<td>Allows the selected users or groups to delete the report. Author Licenses only.</td>
</tr>
<tr>
<td>Edit Report</td>
<td>Allows the selected users or groups to make changes to the report. Author Licenses only.</td>
</tr>
<tr>
<td>Edit Report Security</td>
<td>Allows the selected users or groups to grant security permissions for the report to other users or groups. Author Licenses only.</td>
</tr>
<tr>
<td>View Report</td>
<td>Allows the selected users or groups to view the report. For the user or group to be able to view the report, you must make sure that the permissions for the report data sources, report objects, and filters (optional) used on this report are also set for the selected user or group.</td>
</tr>
</tbody>
</table>
Report data source permissions

There are the following report data source permissions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow &lt;All&gt; Filter Selection</td>
<td>Allows the selected users or groups to select the (all) filter from any column filter list associated with a report data source.</td>
</tr>
<tr>
<td>Delete Report Data Source</td>
<td>Allows the selected users or groups to delete the report data source.</td>
</tr>
<tr>
<td></td>
<td>Author Licenses only.</td>
</tr>
<tr>
<td>Edit Report Data Source</td>
<td>Allows the selected users or groups to make changes to the report data source.</td>
</tr>
<tr>
<td></td>
<td>Author Licenses only.</td>
</tr>
<tr>
<td>Edit Report Data Source Security</td>
<td>Allows the selected users or groups to grant security permissions for the report data source to other users or groups.</td>
</tr>
<tr>
<td></td>
<td>Author Licenses only.</td>
</tr>
<tr>
<td>View Report Data Source</td>
<td>Allows the selected users or groups to view the report data source.</td>
</tr>
</tbody>
</table>

Report object permissions

There are the following report object permissions:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Report Object</td>
<td>Allows the selected users or groups to delete the report object.</td>
</tr>
<tr>
<td></td>
<td>Author licenses only.</td>
</tr>
<tr>
<td>Edit Report Object</td>
<td>Allows the selected users or groups to make changes to the report object.</td>
</tr>
<tr>
<td></td>
<td>Author licenses only.</td>
</tr>
<tr>
<td>Edit Report Object Security</td>
<td>Allows the selected users or groups to grant security permissions for the report object to other users or groups.</td>
</tr>
<tr>
<td></td>
<td>Author licenses only.</td>
</tr>
<tr>
<td>View Report Object</td>
<td>Allows the selected users or groups to view the report object.</td>
</tr>
<tr>
<td></td>
<td>The report object will be available for use by the selected users or groups.</td>
</tr>
</tbody>
</table>
Index

A
A Quick Tour of a Sample Custom Analysis Tool 126
Ad Comment As 84
Add a Comment to a Value, X-axis, or Y-axis on a Time-series Chart 79
Add a Saved Report Object to Your Report 45
Advanced Reporting Topics 97
Aggregate 93
Aggregate, Group, Format, Sort, Chart, and Rename Columns 92
Analysis Tool Architecture 130
Analyzing FactoryTalk Historian Classic Data 41
Analyzing Non-RSBizWare Data 110

C
Changing Chart Component Properties 90
Chart 95
Collecting FactoryTalk Historian Classic Data 19
Configure the Report Object To Use Global Credentials 48
Configure Time-Series Data Collection 22
Configuring Important Project Settings 137
Configuring the Plant Model 20
Connecting to the Information Services Manager 14
Create a New Chart 51
Create a New RSBizWare Report 41
Create a New Text Report Object 60
Create a Report Data Source 111
Create a Simple Batch/Event Chart 76
Create a Time-series Chart 67
Create an External Data Source 110
Creating a New Project 137, 144
Creating RSBizWare Custom Analysis Tools 125
Customizing Charts 87
Customizing RSBizWare Charts and Tables 87
Customizing Text Report Objects 90

D
Debugging Custom Analysis Tools in Visual Basic 142
Debugging Custom Analysis Tools in Visual C++ 154
Deleting a Component 89
Developing Analysis Tools with Visual Basic 136
Developing Analysis Tools with Visual C++ 143
Documentation Feedback 164

E
Editing the Chart Title or Text Field 89
Enterprise Connectors 24
Exploring the User Interface 16
Export the Report to HTML 84

F
Features and Benefits 9
Filter permissions 158
Format 94

G
Getting Started 13
Group 94

I
Insert Text, Pictures, and Hyperlinks 42
Installation Assistance 164
Intended Audience 9, 125
Interpreting the Parameters Passed into the Calculate() Function 133
Index

L
Limitations 134
Load the Report From File 85
Looking at the Type Library 135

M
Moving a Component 89

N
New Product Satisfaction Return 164

O
Object Permissions 157
Organize FactoryTalk Historian Classic Reporting Tags 36

Q
Quick Filter 95

R
Referencing the RSBizWare Calculator Component 138, 145
Registering a Sample Analysis Tool 127
Rename 95
Report data source permissions 159
Report object permissions 159
Report permissions 158
Resize Table Columns 92
Resizing a Component 89
Rockwell Automation Support 164

S
Save the Report 44
Saving and Compiling the Project 140, 151

Schedule a Report 105
Schedule a Report Object 102
Scheduling Report Objects and Reports 101
Shortcut Menus 17
Show and Hide Columns 91
Sort 94
Start Data Collection 39
Step 1
  Create the Report Object 67
  Plan the Chart 52
  Start the Report Data Source Wizard 111
  Start the Text Report Object Wizard 61
  Start the Time-Series Data Collection Wizard 25
Step 2
  Give the Report Data Source a Name 116
  Name the Report Object 68
  Select the Data On Which To Report 53, 61
  Select the Source and Destination of the Time-Series Data 25
Step 3
  Add Reporting Tags 68, 73
  Choose a Chart Type 53
  Create or Select Data Points 27
  Group the Records 62
  Select a Database Table or View 117
Step 4
  Apply an Analysis Tool 69
  Choose the Columns That Will Be Included 117
  Configure Collection Parameters 31
  Describe the Data 53
  Sort the Records 63
Step 5
  Configure Transaction Settings 34
  Customize the Chart Legend 70
  Enable the Time Selection Toolbar 119
  Format the Table 64
  Select Summary or Detail 54
Step 6
  Create Transactions 36
  Insert Your New Chart Into the Report 71
Name the Report Object 66
Select the Fields To Be Charted 55
Specify the Format of the Table or View 120

Step 7
Adjust the Time Range 71
Enter the Chart Title 56
Filter the Data 66
Specify the Role That Each Field Plays In Time-Series Analysis 122

Step 8
Create a Data Point Configuration Table 123
Filter the Data 56
Insert Your New Table Into the Report 66

Step 9
Insert Your New Chart Into the Report 59
Remove a Reporting Tag or an Analysis Tool 76

T
The Excel Add-in 97
The Plant Model 19
The Report Design and Display Work Area 16
The Report Explorer 16
The RSBizWare Architecture 13
The RSBizWare Calculator COM Interface 134
Trying Out the Custom Analysis Tool 153
Trying Out the New Custom Analysis Tool 141
Tutorial 25
Types of control connectors for the data collection 23

U
Using the Configuration Console 15
Using the Information Services Manager in Internet Explorer 14
Using the Sample Analysis Tool for Time-series Analysis 129

V
Value Comments 80
View the History of the Scheduled Task 109

W
Welcome to FactoryTalk Historian Classic 9
What a Time-series Data Set Looks Like 132
What is FactoryTalk Historian Classic? 9
What You Need to Know Before You Start 129
Where Can I Go for Help? 11
Why Use Custom Analysis Tools? 125, 155
Working With Chart 90
Working With the Component Parts of a Chart 88
Working with VARIANTs in Visual C++ 147
Writing the Calculate() Function 138, 148

X
X-axis Comments 81

Y
Y-axis Comments 82
Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. At [http://www.rockwellautomation.com/support/](http://www.rockwellautomation.com/support/) you can find technical and application notes, sample code, and links to software service packs. You can also visit our Support Center at [https://rockwellautomation.custhelp.com/](https://rockwellautomation.custhelp.com/) for software updates, support chats and forums, technical information, FAQs, and to sign up for product notification updates.

In addition, we offer multiple support programs for installation, configuration, and troubleshooting. For more information, contact your local distributor or Rockwell Automation representative, or visit [http://www.rockwellautomation.com/services/online-phone](http://www.rockwellautomation.com/services/online-phone).

Installation Assistance

If you experience a problem within the first 24 hours of installation, review the information that is contained in this manual. You can contact Customer Support for initial help in getting your product up and running.

<table>
<thead>
<tr>
<th>United States or Canada</th>
<th>1.440.646.3434</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outside United States or Canada</td>
<td>Use the <a href="http://www.rockwellautomation.com/rockwellautomation/support/overview.page">Worldwide Locator at http://www.rockwellautomation.com/rockwellautomation/support/overview.page</a>, or contact your local Rockwell Automation representative.</td>
</tr>
</tbody>
</table>

New Product Satisfaction Return

Rockwell Automation tests all of its products to help ensure that they are fully operational when shipped from the manufacturing facility. However, if your product is not functioning and needs to be returned, follow these procedures.

<table>
<thead>
<tr>
<th>United States</th>
<th>Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain one) to your distributor to complete the return process.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outside United States</td>
<td>Please contact your local Rockwell Automation representative for the return procedure.</td>
</tr>
</tbody>
</table>

Documentation Feedback

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete this form, publication [RA-DU002](http://www.rockwellautomation.com/literature/), available at [http://www.rockwellautomation.com/literature/](http://www.rockwellautomation.com/literature/).


[www.rockwellautomation.com](http://www.rockwellautomation.com)

---

Power, Control and Information Solutions Headquarters

Americas: Rockwell Automation, 1201 South Second Street, Milwaukee, WI 53204-2496 USA, Tel: (1) 414.382.2000, Fax: (1) 414.382.4444

Europe/Middle East/Africa: Rockwell Automation NV, Pegasus Park, De Kleestraat 12a, 1831 Diegem, Belgium, Tel: (32) 2 663 0600, Fax: (32) 2 663 0640

Asia Pacific: Rockwell Automation, Level 14, Core F, Cyberport 3, 100 Cyberport Road, Hong Kong, Tel: (852) 2887 4788, Fax: (852) 2508 1846

Rockwell Automation Publication HIST-UM001K-EN-E-June 2014

Supersedes Publication HIST-UM001I-EN-P-December 2011

Copyright © 2014 Rockwell Automation Technologies, Inc. All Rights Reserved.